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Welcome
DocuShare is a web-based application that allows you to easily and efficiently manage 
electronic content. Using DocuShare, you can store and organize content, collaborate with 
other users on projects, search for and retrieve content, and automate document 
processes.

Key DocuShare features enable you to:

• Create and maintain your own account and personal work area without the 
assistance of a web master or site administrator.

• Add documents and other types of objects to your site.

• Maintain multiple versions of a document, track its revision history, and lock a 
document to prevent simultaneous editing.

• Control access to site objects.

• Set up notifications for objects to be notified of any changes, additions, and 
deletions.

• Route documents for approval or review.
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Accessing DocuShare
You access DocuShare by entering the URL of your DocuShare site in a web browser 
window. After you connect to DocuShare, the DocuShare home page is the first page you 
see. From the home page you can log in, access the content on your site, and use the 
navigational links to get to DocuShare features. 

Although your administrator can customize your site home page and different browsers 
may not display site elements the same, your home page should look similar to the 
example shown below.

The DocuShare home page includes these features:

A—Login area

B—The site’s top-level collections, which your administrator sets up and contain all the 
content on your site

C—Navigation links to other DocuShare pages

D—Search area used to run quick searches and to access advanced search features

E—What’s New menu, which you can use to see the content that has been added or 
changed

F—Help on getting started using DocuShare

G—Links to related information

A

B

C
D

E

F

G
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Navigating your site
DocuShare navigation features make it easy to find what you need.

Navigation bar—Includes links to pages and features that are used frequently:

• Home—returns to the home page.

• Content Map—provides a hierarchical display of the objects on your site, based 
on your current location. You can click any object in the Content Map to open it.

• What’s New—lists the new and changed objects on your site.

• Users & Groups—provides links to listing, finding, and creating user and group 
accounts.

• Help—provides access to user guides, tutorials, and software downloads.

• Username—displays your user account properties. Your username displays after 
you log into DocuShare.

• Logout—logs you out of DocuShare. The link displays after you log in.

• My DocuShare—displays your personal home page, which includes your favorites 
and a personal collection and calendar. The link displays after you log in.

• My Tasks—shows the routing tasks assigned to you and the tasks you assigned. 
The link displays after you log in.

• Search area—includes an area for running quick searches as well as a link to the 
Advanced Search page.

Breadcrumbs—Provide a path from the home page to your current location or list the last 
few pages you visited. You can click any link in the breadcrumbs to go to the page. For 
objects that appear in more than one location, multiple breadcrumbs are displayed when 
you click the triangle under Location.

Location: Home > Initial Top Level Collection D > My Collection Listing



Getting started Understanding DocuShare objects

User Guide  1–5

 
 

Understanding DocuShare objects
You create content on your site by adding different types of objects. DocuShare provides 
both container and non-container objects. You organize site content in container objects 
called collections. Depending on your organization’s needs, your site can include any 
number of collections. Objects that you can add to collections include: documents, 
calendars, discussions, and URLs. Calendars and discussions also are containers; 
calendars can include events and topics can be posted to discussions. 

Each DocuShare object is identified by an icon. Table 1–1 shows the current DocuShare 
icons. 

Table 1–1:  DocuShare icons

DocuShare object and its icon

User—A registered DocuShare 
user.

Group—One or more 
DocuShare users, groups, or 
both.

Collection—A container for 
storing DocuShare objects.

Document—A document 
stored on the DocuShare site. 
The icon can vary, depending 
on the document’s file type.

Discussion—An online forum 
where topics can be posted.

Topic—A posting to a 
discussion.

Calendar—An online monthly 
or weekly calendar.

Event—A calendar entry.

Mail Message—An email 
message.

Saved Query—Saved search 
query terms that can be used 
for a search.

Notification—Email notification 
after a change occurs to a 
specified object.

URL—An Internet address for a 
web page.



Understanding DocuShare objects Getting started

1–6  User Guide

 
 

Object permissions
Every object on a site has an owner who can control the type of access that users and 
groups have to it by assigning permissions. Initially, the object’s owner is the user who 
added the object. However, any user with the appropriate access permission can change 
the owner. DocuShare allows you to assign these access permissions to users and 
groups:

• Reader allows the user or group to read the contents of the object and view its 
associated properties and permissions.

• Writer allows the user or group to edit the object’s properties and add new 
objects, including new versions of documents.

• Manager allows the user or group to delete the object, and change the object’s 
access permissions and owner.

Your DocuShare administrator has full access permissions to all of the objects on your 
site. Access permissions provides a complete explanation of how to assign permissions to 
objects.

Object properties
In addition to permissions, every object has a set of properties. For example, the 
properties for all objects include a title, a description, and an owner. Each object has a 
number of specific properties. For example, the sort order property is unique to collections 
and documents have a maximum versions property. Your DocuShare administrator also 
can create custom properties for use at your site. You can assign property values to 
objects, which allows you to categorize objects, provide information about objects to other 
users, and facilitate searches.
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Logging in and out
Your administrator determines the access policies for your site. Therefore, you may be 
able to browse and view content without logging in (as a guest user) or you may be 
required to log in before you can access any site content. 

To log into DocuShare:

1. In a web browser, enter the URL of your DocuShare site.

2. In the Login area, enter your registered username and password in the fields.

Your password is case-sensitive.

3. If the Domain field appears, select your domain name.

The Domain field appears if your site uses the LDAP (Lightweight Directory 
Access Protocol) feature.

4. If the retain login for future checkbox appears, click it if you want to remain 
logged into DocuShare after you close and reopen your browser.

Note: The retain login for future checkbox appears if your administrator configured your 
site to allow users to remain logged in after closing their browser. For DocuShare to 
save your password, Internet Explorer’s Do not save encrypted pages to disk 
option cannot be enabled. You can check the option’s setting by selecting Internet 
Options from the Tools menu and then clicking the Advanced tab.

5. Click Go.

Your username appears on the navigation bar, indicating that you are logged in.

To log out of DocuShare:

1. Do one of the following:

• Close the browser window.

• If you selected the retain login for future checkbox, click the Logout link on 
the navigation bar.
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How to get help
In addition to this guide, the Help Desk includes other guides and a tutorial. The 
Documentation page provides user guides for the add-ons applicable to your site. The 
Training page includes a User Tutorial, which helps you get started using DocuShare by 
following a series of step-by-step exercises. 

DocuShare User Group
The DocuShare User Group, DoUG, provides access to additional product information, 
hints and tips from other user group members, and knowledge base articles. To sign up 
with the user group, go to http://docushare.xerox.com:8002.
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DocuShare Client applications
The Downloads page on the Help Desk provides several Client applications to extend 
DocuShare’s functionality:

DocuShare Windows Client—A Windows-based application that seamlessly integrates 
DocuShare's document management features within your Windows desktop environment. 
From your Windows desktop you can easily access DocuShare content, drag and drop 
documents between DocuShare collections and your local and network drives, and open, 
edit, and save DocuShare documents from a variety of applications.

DocuShare Outlook Client—A Windows-based application that enables you to 
conveniently manage and share information within Microsoft Outlook. Mapped DocuShare 
servers and collections appear as mail folders in your Inbox’s Folder List. Open a folder to 
browse the contents of a collection, open documents for editing, and save new versions of 
documents. You can easily archive and share mail messages and attachments by 
dragging and dropping them to a collection. When you need to find information quickly, 
you can perform keyword searches.

PaperPort Link to DocuShare—A program link for the popular ScanSoft PaperPort 
application that is included with many desktop scanners. The link enables you drag and 
drop scanned documents from your PaperPort desktop to DocuShare.
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About DocuShare accounts
By default, DocuShare is a community-maintained site, allowing anyone to create user 
and group accounts. Depending on the needs of your site, the DocuShare administrator 
can restrict account creation to logged-in users or to an administrator.

Additionally, if your site uses the LDAP (Lightweight Directory Access Protocol) feature to 
manage user accounts, an administrator creates an account for you. To find out how your 
site is configured, see your DocuShare administrator.
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DocuShare user accounts
When you first access DocuShare or until you log in, you are considered a guest user. As 
a guest, you can browse any unrestricted, or public, content. To add objects and edit 
content, you must have a DocuShare user account.

Creating a user account
If your site allows guest users to create accounts, you can create a user account. If 
account creation is restricted, an administrator will need to create a user account for you.

To create a user account:

1. On the navigation bar, click Users & Groups. 

2. Click the Add User link.

3. On the Add User page, enter the following information:

Username—The name you want to use to log into DocuShare.

Password—The password you want to use to log into DocuShare. Your 
administrator can specify that your password adhere to a set of rules. If specified, 
the rules appear on the page.

Your password is case-sensitive and must be typed as specified when logging in.

Password Confirm—The same password that you typed in the Password field.

Domain—An organization or other entity on your DocuShare site. This field 
appears if your site uses the LDAP feature; the menu lists both internal and LDAP 
domains.

Last Name—Your last name. Users are listed on the DocuShare site by their first 
and last names.

4. Enter any optional information. Click a field name for a description of each 
property.

Note: If your administrator created custom properties, they also display on the page. See 
your administrator for information about custom properties.

5. Click Apply.

The View Properties page for the user account appears.

If DocuShare was unable to create a new account, a message page appears 
describing the problem.
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Viewing user account properties
You can view the properties of any DocuShare user account. To view the properties, you 
do not need to be logged into DocuShare.

To view a user’s account properties:

1. On the navigation bar, click Users & Groups.

2. On the List page, select Users in the Show field.

3. Do one of the following:

• To find a specific user account, enter part of the user’s first name, last name, 
or username in the Search field. Click the Go button.

• To display all user accounts, click Show All.

4. From the displayed list, click the name of the user whose properties you want to 
view.

The View Properties page appears, displaying the user’s properties. Click a field 
name for a description of each property. 

Changing your user account properties
You must be logged in as the user whose properties you want to change. You can view, 
but not change, another user’s properties.

To change your user account properties:

1. On the navigation bar, click your username.

The View Properties page appears.

2. Click the Edit link.

3. Change the properties you want. Click a field name for a description of each 
property.

4. Click Apply.
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Changing your password
You must be logged in as the user whose password you want to change. You cannot 
change another user’s password.

Note: If your site uses the LDAP feature, you cannot change your password. Your 
administrator must change your password on the LDAP server.

To change your current password:

1. On the navigation bar, click your username.

The View Properties page appears.

2. Click the Change Password link.

3. Enter your current password in the Old Password field.

4. Enter your new password in the New Password field.

Your administrator can specify that your password adhere to a set of rules. If 
specified, the rules appear on the page.

5. Enter your new password in the New Password Confirm field.

6. Click Apply.

Changing your username
You must be logged in as the user whose username you want to change. You cannot 
change another user’s username.

Note: If your site uses the LDAP feature, you cannot change your username. Your 
administrator must change your username on the LDAP server.

To change your username:

1. On the navigation bar, click your username.

The View Properties page appears.

2. Click the Change Username link.

3. Enter your current password in the Password field.

4. Enter a new username in the Username field.

5. Click Apply.

The View Properties page appears displaying your new username. The new name 
also appears on the navigation bar.
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Changing your domain
If your site uses the LDAP feature, you can change your domain to an internal domain on 
the DocuShare server. You must be logged in as the user whose domain you want to 
change; you cannot change another user’s domain.

To change your current domain:

1. On the navigation bar, click your username.

The View Properties page appears.

2. Click the Change Domain link.

3. Select a new domain from the Domain menu.

4. Click Apply.

Changing federation settings
DocuShare federation enables you to search multiple DocuShare sites to easily access 
content located on several servers. If your site is a member of a DocuShare federation (a 
Federation icon appears on the lower-left corner of a DocuShare page), you must map 
your user account information to the other member servers that you want to access. 

To map your user account:

1. On the navigation bar, click your username.

The View Properties page appears.

2. Click the Federation Settings link.

The Federation Settings page lists the servers in your federation.

3. Click the Edit Mapping link that appears to the right of the server to which you 
want to map.

The Edit Mapping page appears. If you know your username on the server, 
continue with step 4. To search for your username, go to step 5. 

Note: If you do not have an account on the server, see the procedure To create a user 
account on a federated server below.

4. To enter your account information, click Enter manually and do the following:

a. Enter your username, password, and domain (if applicable).
b. Click Apply.
Your username appears on the Federation Settings page.

5. To select your user account from a list, click Choose from list and do the 
following:

a. Find your account by doing one of the following:
• Enter part of your first name, last name, or username in the Search field 

and click the Go button.

• Click Show All to display all user accounts.
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• Click Show users with my email address to display the accounts with 
your email address.

b. Select your account.
c. Enter the password for the account.
d. Click Apply.
Your username appears on the Federation Settings page.

To create a user account on a federated server:

1. On the Edit Mapping page, click the Create a new user account on this server 
link.

The Add User page on the server on which you are creating the account appears.

Note: If the site does not allow guest access, you cannot create an account.

2. Enter your account information and click Apply.

3. Click the browser’s Back button until you return to the Edit Mapping page on the 
initial server.

4. Click Choose from list.

5. Display your account and select it.

6. Enter your password.

7. Click Apply.

Your username appears on the Federation Settings page.

To remove an account mapping:

1. On the navigation bar, click your username.

The View Properties page appears.

2. Click the Federation Settings link.

The Federation Settings page lists the servers in your federation.

3. Click the Edit Mapping link that appears to the right of the server whose mapping 
you want to remove.

4. On the Edit Mapping page, click No user mapping.

5. Click Apply.

Your username does not appear next to the server on the Federation Settings 
page.

Deleting a user account
Only an administrator can delete an existing user account. Contact your administrator if 
you want to delete your user account. If you have several user accounts, your 
administrator can combine any number of the accounts into one account.



DocuShare group accounts Users and groups

2–8  User Guide

 
 

DocuShare group accounts
A group consists of any number of DocuShare users, groups, or both. When your site 
includes groups, you can more easily manage access to objects by assigning permissions 
to the group instead of to each user.

Creating a group
The DocuShare administrator can choose to allow logged-in users to create group 
accounts or to have group account creation under administrative control. If after logging 
into DocuShare, you do not see the Add Group link on the Users and Groups Registry 
page, then an administrator will need to create a group for you.

To create a group:

1. On the navigation bar, click Users & Groups.

2. Click the Add Group link.

3. In the Title field, enter a name for the group. The name can contain spaces and 
punctuation marks, and can be identical to another group name.

4. In the Domain field, select a domain name. This field appears if your site uses the 
LDAP feature; the menu lists both internal and LDAP domains.

5. Enter any optional information. Click a field name for a description of each 
property.

Note: If your administrator created custom properties, they also display on the page. See 
your administrator for information about custom properties.

6. Click Apply.

The Change Membership page appears.

7. In the Show field, select the type of account you want to display in the Possible 
Users/Groups field.

8. Do one of the following:

• To find a specific account, enter part of the user’s first name, last name, or 
username or the group’s title in the Search field. Click the Go button.

• To display all accounts, click Show All.

• To display your favorite accounts, click Show Favorites.

9. In the Possible Users/Groups field, select the accounts to add to the group and 
click the Add button. To select multiple accounts, use the CTRL key (Windows) or 
the Command key (Macintosh).

10. In the Selected Users/Groups field, select any accounts that you want to remove 
from the group and click the Remove button. To select multiple accounts, use the 
CTRL key (Windows) or the Command key (Macintosh).
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11. Click Update.

The group members display on the Members page.

Viewing group properties
You can view the properties of any DocuShare group. To view the properties, you do not 
need to be logged into DocuShare.

To view a group’s properties:

1. On the navigation bar, click Users & Groups.

2. On the List page, select Groups in the Show field.

3. Do one of the following:

• To find a specific group account, enter part of the group’s title in the Search 
field. Click the Go button.

• To display all group accounts, click Show All.

4. From the displayed list, click the name of the group whose properties you want to 
view.

The View Properties page for the group appears. Click a field name for a 
description of each property. 

Changing group properties
Depending on the Change Membership setting, either the logged-in owner of the group 
or a logged-in group member can change the properties of a group.

To change a group’s properties:

1. On the navigation bar, click Users & Groups.

2. On the List page, select Groups in the Show field.

3. Do one of the following:

• To find a specific group account, enter part of the group’s title in the Search 
field. Click the Go button.

• To display all group accounts, click Show All.

4. From the displayed list, click the group whose properties you want to change.

The View Properties page for that group appears.

5. Click the Edit link.

6. Change the properties that you want. Click a field name for a description of each 
property.

7. Click Apply.
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Changing the members of a group
Depending on the Change Membership setting, either the logged-in owner of the group 
or a logged-in group member can change the members of the group.

To change a group’s members:

1. On the navigation bar, click Users & Groups.

2. On the List page, select Groups in the Show field.

3. Do one of the following:

• To find a specific group account, enter part of the group’s title in the Search 
field. Click the Go button.

• To display all group accounts, click Show All.

4. From the displayed list, click the group whose members you want to change.

The View Properties page for that group appears.

5. Click the Members link.

The Members page shows the current group members.

6. To change group members, click the Change Membership button.

7. In the Show field, select the type of account you want to display in the Possible 
Users/Groups field.

8. Do one of the following:

• To find a specific account, enter part of the user’s first name, last name, or 
username or the group’s title in the Search field. Click the Go button.

• To display all accounts, click Show All.

• To display your favorite accounts, click Show Favorites.

9. In the Possible Users/Groups field, select the accounts to add to the group and 
click the Add button. To select multiple accounts, use the CTRL key (Windows) or 
the Command key (Macintosh).

10. In the Selected Users/Groups field, select any accounts that you want to remove 
from the group and click the Remove button. To select multiple accounts, use the 
CTRL key (Windows) or the Command key (Macintosh).

11. Click Update.

The group members display on the Members page.
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Changing the owner of a group
Only the logged-in owner of the group can change its owner. After changing the group’s 
owner to another user, you will no longer be able to change the group’s members and 
properties, unless Change Membership is set to Members.

To change the owner of an existing group:

1. On the navigation bar, click Users & Groups.

2. On the List page, select Groups in the Show field.

3. Do one of the following:

• To find a specific group account, enter part of the group’s title in the Search 
field. Click the Go button.

• To display all group accounts, click Show All.

4. From the displayed list, click the group whose owner you want to change.

The View Properties page for that group appears.

5. Click the Edit link.

6. Click Change Owner.

The Change Owner page appears.

7. Do one of the following:

• To find a specific user account, enter part of the user’s first name, last name, 
or username in the Search field. Click the Go button.

• To display all user accounts, click Show All.

• To display your favorite accounts, click Show Favorites.

8. Select a name from the New Owner field.

9. In the Add Owner to Group field, click Yes to add the new owner to the group.

10. Click Update Owner.
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Changing the domain of a group
If your site uses the LDAP feature, you can change a group’s domain to an internal 
domain on the DocuShare server. You must be the logged-in owner of the group to 
change its domain.

Note: Changing the group’s domain does not change a group member’s domain, if one is 
used.

To change a group’s domain:

1. On the navigation bar, click Users & Groups.

2. On the List page, select Groups in the Show field.

3. Do one of the following:

• To find a specific group account, enter any part of the group’s title in the 
Search field. Click the Go button.

• To display all group accounts, click Show All.

4. From the displayed list, click the group whose domain you want to change.

The View Properties page for that group appears.

5. Click the Change Domain link.

6. Select a new domain from the Domain menu.

7. Click Apply.

Sending mail to group members
To easily communicate with a DocuShare group, you can send an email message to the 
group’s members. The message is sent to each member whose user properties include an 
email address. To send email, your web browser must be correctly configured with a mail 
client, such as Microsoft Outlook or Netscape Communicator.

To send email to the members of a group:

1. On the navigation bar, click Users & Groups. 

2. On the List page, select Groups in the Show field.

3. Do one of the following:

• To find a specific group account, enter part of the group’s title in the Search 
field. Click the Go button.

• To display all group accounts, click Show All.

4. From the displayed list, click the group that you want to send an email message 
to.

The View Properties page for that group appears.

5. Click the Email link.

6. To write your message, click the here link.
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Your browser launches an untitled message window with each group member’s 
email address entered in the To field.

7. Compose your message and click Send to email the message to the members of 
the group.

Deleting a group
You can delete a group if you are the logged-in owner of the group.

To delete a group:

1. On the navigation bar, click Users & Groups.

2. On the List page, select Groups in the Show field.

3. Do one of the following:

• To find a specific group account, enter any part of the group’s title in the 
Search field. Click the Go button.

• To display all group accounts, click Show All.

4. From the displayed list, click the group that you want to delete.

The View Properties page for that group appears.

5. At the bottom of the page, click the Delete button.

The Confirm Delete page appears.

6. Click Delete to remove the group from your site.

If you do not want to delete the group, click Cancel.
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Finding and listing DocuShare accounts
From the List page, you can quickly search the users and groups registry to determine 
whether or not a user or group has an account on the DocuShare site. You also can list all 
of the user and group accounts registered on the site.

To search for a user or group:

1. On the navigation bar, click Users & Groups.

2. On the List page, select the type of account you want to find in the Show field.

3. In the Search field, enter a complete name or part of a name.

4. Click Go.

The search results display, listing the users, groups, or both who match the search 
text.

To list the accounts on your site:

1. On the List page, select the type of account you want to list in the Show field.

2. Click Show All.

The list of all registered accounts displays.
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About collections
Your DocuShare site consists of any number of repositories, called collections, in which 
you store documents and other objects. The administrator determines which initial set of 
collections appears on the DocuShare home page. As a registered user, you can add 
collections to your DocuShare site.
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Adding a collection
You can add a collection to another collection if you are logged in and have Writer access 
to the existing collection. 

To add a collection:

1. Navigate to and open the container to which you want to add a collection.

2. From the Add menu, select Collection.

The Add Collection page appears.

3. In the Title field, enter a name for the collection. The name should be short, but 
descriptive, and can contain spaces and punctuation marks.

4. Enter any optional information. Click a field name for a description of each 
property.

Note: If your administrator created custom properties, they also display on the page. See 
your administrator for information about custom properties. 

5. Click Apply.

The collection is added to the container.

To change the collection’s access permissions, see Access permissions. 
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Viewing and changing collection properties
You do not need to be logged into DocuShare to view a collection’s properties. However, 
only the logged-in owner of a collection or a logged-in user with Writer access to the 
collection can change the properties.

To view and change a collection’s properties:

1. Locate the collection whose properties you want to view and change.

2. Do one of the following:

• If the collection is open, click the Properties icon in the upper-right corner of 
the window.

• If the collection is not open (you can view its title in a container), click the 
Properties icon that appears to the right of the collection’s title.

The View Properties page appears.

3. Click the Edit link.

4. Change the properties you want. Click a field name for a description of each 
property.

Note: If your administrator created custom properties, they also display on the page. See 
your administrator for information about custom properties.

5. Click Apply.
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Changing the location of a collection
You can move a collection to another container or have the collection appear in several 
containers on your site. Although a collection can appear in several containers, there is 
only one copy of it, which saves space on your DocuShare site.

To change a collection’s location, you must be logged in and have Writer access to both 
the collection and the new container.

Note: You can also use the Copy, Cut, and Paste commands from the Edit Selected 
menu to change the location of a collection. See Editing multiple objects in a 
collection on page 3–7.

To change a collection’s location:

1. Locate the collection whose location you want to change.

2. Do one of the following:

• Click the checkbox that appears next to the collection’s title. From the Edit 
Selected menu, select Change Location. On the Confirm Change Location 
page, click Confirm.

• Click the Properties icon that appears to the right of the collection’s title. On 
the Properties page for the collection, click the Locations link.

The Change Location page appears.

3. In the Sort By field, select Title to display the possible containers in alphabetical 
order or select Handle to display the possible containers in numerical order.

4. Do one of the following:

• To find specific containers, enter any part of a container title in the Search 
field. Click the Go button.

• To display all containers, click Show All.

• To display your favorite containers, click Show Favorites.

5. In the Possible Locations field, select the container(s) in which you want the 
collection to appear and click the Add button. To select multiple containers, use 
the CTRL key (Windows) or the Command key (Macintosh).

6. In the Selected Locations field, select any containers in which you do not want 
the collection to appear and click the Remove button. To select multiple 
containers, use the CTRL key (Windows) or the Command key (Macintosh).

Note: Make sure at least one container appears in the Selected Locations field. 
Otherwise, the collection will become orphaned, which means it will not appear in 
any container.

7. Click Update Locations.
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Deleting a collection
You can delete a collection if you are the logged-in owner of the collection or have 
Manager access to it. If the collection contains other objects, you can choose to delete the 
collection only or the collection and its contents. To delete the collection and its contents, 
you must be the owner of the objects in the collection or have Manager access permission 
to them.

If you accidentally delete a collection, your administrator can restore it if the trashcan is 
enabled on your site. The trashcan holds deleted objects until your administrator 
expunges or restores the trashcan contents. See your administrator to restore a deleted 
collection. 

Note: If you delete a collection, but not its contents, and the objects are not located in 
another collection, they become orphaned. You are unable to access orphaned 
objects from a collection. Your administrator can relocate orphaned objects in a 
collection so you can access them again.

To delete a collection:

1. Locate the collection that you want to delete.

2. Do one of the following:

• Click the checkbox that appears next to the collection’s title. From the Edit 
Selected menu, select Delete.

• From the collection’s More Actions menu, select Delete.

The Confirm Delete page appears.

Note: If a minus sign appears in the checkbox that precedes the collection, then you do 
not have Manager access to the object and cannot delete it.

3. From the For collections, delete menu, do one of the following:

• Select Collection and Contents to delete the collection and all of the objects 
in it.

• Select Collection Only to delete the collection, but not its contents.

4. Click Delete to remove the collection from your site.

If you do not want to delete the collection, click Cancel.
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Editing multiple objects in a collection
When viewing an open collection, you can use the Edit Selected menu to perform a 
variety of tasks on one or more objects. The menu includes these commands:

• Add to Favorites—Add the object to Favorites on My DocuShare. 

• Archive and Restore—Move the object to and retrieve the object from an Archive 
Server (commands appear if your site uses an Archive Server). See Archiving 
content for more information.

• Change Location—Add the object to another location.

• Change Owner—Change the object’s owner.

• Copy—Copy the object to the clipboard. 

• Cut—Cut the object to the clipboard.

• Paste—Paste the object from the clipboard.

• Delete—Remove the object from your site.

• Rename—Change the object’s title.

• Route—Send the document to users for approval, review, or information. See 
Routing documents for more information.

To edit multiple collection objects:

1. Navigate to and open the collection.

2. Do one of the following:

• To edit some of the objects, click the checkbox next to the objects you want.

• To edit all of the objects, click the checkbox to the left of the Type column 
heading.

3. From the Edit Selected menu, select the command you want.

A confirm window appears.

4. Click Confirm to continue. Depending on which command you selected, 
additional pages may appear.

Note: When using the Change Location command, if an object appears in more than 
one collection, only the current collection is listed in the Selected Locations field.

Using Copy, Cut, and Paste to change the location of an 
object
To copy or cut objects:

1. Locate the object that you want to copy or cut.

2. Click the checkbox next to the object.

3. From the Edit Selected menu, select either Copy or Cut.

A confirm window appears.
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4. Choose whether or not to remove any objects from the clipboard before the copy 
or cut.

5. Click Confirm.

Note: When using the Cut command, the object is grayed until you Paste it to another 
container.

6. Open the container in which you want to paste the object.

7. From the Edit Selected menu, select Paste.

A confirm window appears.

8. Choose whether or not to remove any objects from the clipboard after the paste.

9. Click Confirm.

The object appears in the container.
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About documents
Using DocuShare, you can store, access, and manage documents created in a variety of 
popular formats. You add documents to DocuShare by uploading them from your 
computer or a network drive to a collection on your site. With the documents stored on 
DocuShare, users connected to the network can use their browser to search for, view, 
edit, and download a document.

For document management, DocuShare supports version control and document locking. 
By default, DocuShare saves four versions of a document; you can change the number of 
versions DocuShare saves on a per-document basis. In addition, you can change a 
document’s preferred version, which is the version that opens when users view, edit, and 
route the document. By default, a document’s preferred version is its latest version.
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Adding a document
You add a document to a collection by uploading it from a folder on your local drive or a 
network drive. The upload copies the document to the container, where it is available to 
others for viewing or collaborative work.

To add a document, you must be logged in and have Writer access to the container.

To add a document:

1. Navigate to and open the container to which you want to add the document.

2. From the Add menu, select Document.

The Add Document page appears.

3. Enter the following information:

Filename—The complete path and filename of the document you want to upload. 
You can click the Browse button to navigate to and select the document.

If you enter the path and filename of a document that does not appear on the 
drive, DocuShare uploads an empty document.

Title—The title of the document. The document's filename appears in the Title 
field. You can use the default title or change it. The title can contain spaces and 
punctuation marks.

Max Versions—The maximum number of versions to save. When a new version 
of a document is saved to DocuShare, the oldest version is deleted, unless it is 
the preferred version.

4. Enter any optional information. Click a field name for a description of each 
property.

5. Click Apply to upload the document.

The document is added to the container. If you chose to route the document, a 
Routing Slip appears. For information on how to use the Routing Slip, see Routing 
documents.

Note: DocuShare identifies each object on the site with a unique handle (for example, 
Document-37). Therefore, you can upload a document that has a name identical to 
a document already stored on DocuShare.
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Viewing a document
When opening a document to view it, you choose to either open or save (download) the 
document. The download copies the document and keeps the original document on 
DocuShare.

Your browser controls how a document is displayed. By design, browsers are able to 
handle several types of documents and files, such as HTML, GIF, and JPEG. However, for 
some documents, such as Microsoft Word and Excel, your browser launches a helper 
application (viewer) to run or display the document either outside or within the browser 
window. To play multimedia files, the browser uses a plug-in, which opens the file within 
the browser window.

Your browser is preconfigured to use specific helper applications and plug-ins. Generally, 
if you try to open a document or file that your browser does not recognize, it displays a 
window that guides you in finding the application to use for that type of file.

Unless access to a document is restricted, you can view any document on your site. 

To view a document:

1. Locate the document that you want to view.

2. Click the document’s title.

A window appears allowing you to open or download the document.

3. To return to the container page after opening the document, do one of the 
following:

• If the document opened in a separate window, select Exit from the File menu.

• If the document opened within the browser window, click the browser’s Back 
button.

Note: If you click the X in the top-right corner of the browser or select Close from the File 
menu, your browser closes and you lose your connection to the DocuShare site.
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Viewing an HTML rendition of a document
DocuShare provides an HTML conversion feature that lets you view supported document 
types in HTML format. This feature eliminates the need to configure your browser to 
display certain document types. 

Note: The HTML conversion feature cannot convert documents that contain encrypted 
information.

To view an HTML rendition of a document:

1. Locate the document that you want to view.

2. From the document’s More Actions menu, select View in HTML.

DocuShare converts the document to HTML and displays the document.

3. Click the browser’s Back button to return to the container page.
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Editing a document
DocuShare supports the complete development cycle of a document, allowing users to 
collaborate on a project. Document check out and locking ensures that only one user at a 
time edits a document. Version control maintains a user-specified number of document 
versions.

To edit a document and create a new version, you must be either the logged-in owner of 
the document or a logged-in user with Writer access to it. In addition, the document’s Add 
Versions property must be set to Allowed (default setting). 

Note: If DocuShare Windows Client is installed on your computer and you enabled the 
Handle checkout from web browser property in the DocuShare Client Properties 
window, the DocuShare Client Checkin Wizard displays after you edit and save the 
document. When using this feature, make sure DocuShare’s URL in the browser is 
the same as the server’s address in Windows Client. To check the server’s 
address, right-click the server name and select Properties.

To edit a document:

1. Locate the document that you want to edit.

2. Click the document’s Check Out icon.

A window appears allowing you to open or download the document.

3. Edit the document.

4. Do one of the following:

• If the document opened in the browser, click the Back button. Click Yes to 
save your edits.

• If the document opened in its native editor, select Save As from the File 
menu.

5. In the Save As window, save the document to a location on your local drive.

Do not change the name of the document.

6. On the container page, click the document’s Upload a New Version icon.

The Add Version page appears.

7. Click the Browse button.

8. Navigate to the location on your local drive in which you saved the edited 
document, select it, and click Open.

The path to the document appears in the Filename field.

9. In the Title field, you can change the document title. By default, the new version is 
assigned the original document title.

10. Optionally, enter any comments in the Version Comments field.

11. If you locked the document, choose whether or not you want to unlock the 
document after adding the new version in the Unlock Document field.
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12. When a document version other than the latest is the preferred version, you can 
click Yes in the Make This The Preferred Version field to set this version as the 
preferred one. Otherwise, click No to not change the preferred version.

13. Click Apply.
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Adding a new version of a document
You can add a new version of a document by uploading a document from a folder on your 
local drive or a network drive. To add a new version, you must either be the logged-in 
owner of the document or have Writer access to it. 

To add a new version of a document:

1. Locate the document that you want to update with a new version.

2. Click the document’s Upload a New Version icon.

The Add Version page appears.

3. Click the Browse button.

4. Navigate to the location on your local drive that contains the document you want 
to add as a new version, select it, and click Open.

The path to the document appears in the Filename field.

5. In the Title field, you can change the document title. By default, the new version is 
assigned the original document title.

6. Optionally, enter any comments in the Version Comments field.

7. If the previous version of the document was locked, the Unlock Document field 
appears. Click No if you do not want to unlock the document after adding the new 
version.

8. When a document version other than the latest is the preferred version, you can 
click Yes in the Make This The Preferred Version field to set this version as the 
preferred one. Otherwise, click No to not change the preferred version.

9. Click Apply.
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Managing document versions
DocuShare’s version control feature enables you to maintain a record of a document's 
history. For each version DocuShare saves, you can view the content, the date and time 
the version was added, the user who added the version, and any user-provided comment. 
You can also view and edit each version’s properties and permissions, and route individual 
versions. 

By default, DocuShare saves four versions of a document. You can change the default 
setting by changing the document's Max Versions property. See Viewing and changing 
document properties on page 4–12.

Viewing document versions
To view a document’s version history:

1. Locate the document whose version history you want to view.

2. Click the document’s Properties icon.

The View Properties page appears.

3. Click the Version History link.

The page displays all saved versions of the document.

4. To view a specific version of the document, click its type or version number.

5. To return to the Version History page, do one of the following:

• If the document opened in a separate window, select Exit from the File menu.

• If the document opened within the browser window, click the browser’s Back 
button.

Changing the preferred version
By default, a document’s preferred version is the latest version. When there is more than 
one version of a document, you can change the document’s preferred version. This is the 
version of the document that opens when users view, edit, and route the document. 
However, users can route a specific document version from the document’s Version 
History page.

DocuShare always saves the preferred version, regardless of the number of Max 
Versions specified.

To change a document’s preferred version:

1. Display a document’s Version History page.

2. Click Change Preferred Version.

Radio buttons display next to each version and the Use Latest Version option 
appears.
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3. Do one of the following:

• To select one of the existing versions as the preferred version, click the radio 
button next to the version you want.

• To always have the latest version of the document be the preferred version, 
click the radio button next to Use Latest Version.

4. Click Apply.

Viewing the renditions of a version
Each version of a document can consist of a number of renditions. A rendition is the 
version’s display format, such as Microsoft Word, Adobe PDF, or HTML, and can be 
comprised of content files. For example, an HTML rendition of a particular document 
version would consist of the HTML file and several image files if the rendition contained 
graphics. 

To view a version’s renditions:

1. Display a document’s Version History page.

2. To view the version renditions, click Show Renditions.

The version renditions display and, if a rendition contains content files, those files 
display.

3. You can click a rendition or a content file to view it.

4. Click Hide Renditions to not view the renditions.

Viewing and changing version properties
Any user can view the properties of a version. You can change a version’s properties if 
you are the logged-in owner of the version or a logged-in user with Writer access to the 
version. 

To view and change a version’s properties:

1. Display a document’s Version History page.

2. Click the document version’s Properties icon.

The View Properties page appears.

3. Click the Edit link.

4. Change the properties you want. Click a field name for a description of each 
property.

5. Click Apply.

To change a version’s access permissions, see Access permissions.
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Locking and unlocking a document
You can lock a document when you want to keep other users from editing it. To lock a 
document, you must be the logged-in owner of the document or a logged-in user with 
Writer access to it.

To allow users to edit a locked document, you need to unlock the document. To unlock a 
document, you must be the logged-in owner of the document or a logged-in user with 
Writer access to it. A document is locked if a Lock icon appears to the left of the 
document’s title.

To lock a document:

1. Locate the document that you want to lock.

2. From the document’s More Actions menu, select Lock.

A Lock icon appears to the left of the document title. Users can view the 
document, but they cannot edit it.

To unlock a locked document:

1. Locate the document that you want to unlock.

2. From the document’s More Actions menu, select Unlock.

A Lock icon no longer appears to the left of the document’s title. Users can now 
edit the document.
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Viewing and changing document properties
Any user can view the properties of a document. You can change a document’s properties 
if you are the logged-in owner of the document or a logged-in user with Writer access to 
the document.

To view and change a document’s properties:

1. Locate the document whose properties you want to view and change.

2. Click the document’s Properties icon.

The View Properties page appears.

3. Click the Edit link.

4. Change the properties you want. Click a field name for a description of each 
property.

Note: If your administrator created custom properties, they also display on the page. See 
your administrator for information about custom properties.

5. Click Apply.



DocuShare documents Changing the location of a document

User Guide  4–13

 
 

Changing the location of a document
You can move a document to another container or have the document appear in several 
containers on your site. Moving a document eliminates the need to delete the document 
and then upload it again. Although a document can appear in several containers, there is 
only one copy of it, which saves space on your DocuShare site.

To change a document’s location, you must be logged in and have Reader access to the 
document and Writer access to the new container.

Note: You can also use the Copy, Cut, and Paste commands from the Edit Selected 
menu to change the location of a document. See Editing multiple objects in a 
collection on page 3–7.

To change a document’s location:

1. Locate the document that you want to move.

2. Do one of the following:

• Click the checkbox that appears next to the document’s title. From the Edit 
Selected menu, select Change Location. On the Confirm Change Location 
page, click Confirm.

• Click the Properties icon that appears to the right of the document’s title. On 
the View Properties page, click the Locations link.

The Change Location page appears.

3. In the Sort By field, select Title to display the possible containers in alphabetical 
order or select Handle to display the possible containers in numerical order.

4. Do one of the following:

• To find specific containers, enter any part of a container title in the Search 
field and click Go.

• To display all containers, click Show All.

• To display your favorite containers, click Show Favorites.

5. In the Possible Locations field, select the container(s) in which you want the 
document to appear and click the Add button. To select multiple containers, use 
the CTRL key (Windows) or the Command key (Macintosh).

6. In the Selected Locations field, select any containers in which you do not want 
the document to appear and click the Remove button. To select multiple 
containers, use the CTRL key (Windows) or the Command key (Macintosh).

Note: Make sure at least one container appears in the Selected Locations field. 
Otherwise, the document will become orphaned, which means it will not appear in 
any container.

7. Click Update Locations.
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Deleting a document
You can delete a document if you are the logged-in owner of the document or a logged-in 
user with Manager access to it. 

If you accidentally delete a document, your administrator can restore it if the trashcan is 
enabled on your site. The trashcan holds deleted objects until your administrator 
expunges or restores the trashcan contents. See your administrator to restore a deleted 
document.

To delete a document:

1. Locate the document that you want to delete.

2. Do one of the following:

• Click the checkbox that appears next to the document’s title. From the Edit 
Selected menu, select Delete.

• From the document’s More Actions menu, select Delete.

The Confirm Delete page appears.

Note: If a minus sign appears in the checkbox that precedes the document, then you do 
not have Manager access to the object and cannot delete it.

3. Click Delete to remove the document from your site.

If you do not want to delete the document, click Cancel.
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About access permissions
Every DocuShare object has a set of associated permissions called its access list. 
Permissions are the access rights that a defined set of users and groups has to view, 
delete, or change a DocuShare object. The object's owner or any user with Manager 
access to the object can assign and change the permissions.

As the owner of the DocuShare objects that you add to your site, you can control the type 
of access users and groups have to those objects. When you add an object to a container, 
you set the object’s initial permissions. At any time you can change the users and groups 
who have access to the object and the type of access each user or group has.

DocuShare provides the following access permissions that you can assign to users and 
groups:

• Reader allows the user or group to read the contents of the object and view its 
associated properties and permissions.

• Writer allows the user or group to edit the object’s properties and add new 
objects, including new versions of documents.

• Manager allows the user or group to delete the object, and change the object’s 
access permissions and owner.

In addition, you can control who can see an object in a search results list.
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Viewing the access permissions of an object
As a guest user or a user with Reader access to an object, you can view the object’s 
access permissions.

To view an object’s access permissions:

1. Locate the object whose permissions you want to view.

2. From the object’s More Actions menu, select Permissions.

The Permissions page for the object appears.

The Permissions page displays the object’s access list, which includes the 
object’s owner, the site administrator, and three DocuShare groups:

Content Administrators—The registered users who have full access 
permissions to all of the objects on your DocuShare site.

All Users and Guest—All registered DocuShare users and the guest user.

All Users Except Guest—All registered DocuShare users.
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Changing the access permissions of an object
You can change an object’s access permissions if you are the logged-in owner of the 
object or a logged-in user with Manager access to the object.

To change an object’s access permissions:

1. Locate the object whose permissions you want to change.

2. From the object’s More Actions menu, select Permissions.

The Permissions page for the object appears.

3. For Search Available to, do one of the following:

• Click Anyone to allow guests and users to view the object in a search results 
list.

• Click Access List Only to allow only those accounts in the object’s access list 
that have at least Reader access to see the object in a search results list.

4. If you want to change the list of users and groups who have access to the object, 
click the Change Access List button.

The Change Access List page appears.

5. In the Show field, select the type of account you want to display in the Possible 
Users/Groups field.

6. Do one of the following:

• To find a specific account, enter part of the user’s first name, last name, or 
username or the group’s title in the Search field. Click the Go button.

• To display all accounts, click Show All.

• To display your favorite accounts, click Show Favorites.

7. In the Possible Users/Groups field, select the accounts to add to the access list 
and click the Add button. To select multiple accounts, use the CTRL key 
(Windows) or the Command key (Macintosh).

8. In the Selected Users/Groups field, select any accounts that you want to remove 
from the access list and click the Remove button. To select multiple accounts, use 
the CTRL key (Windows) or the Command key (Macintosh).

9. Click Update Access List.

The Permissions page appears, displaying the new access list.

10. Check the permission boxes you want for each user and group displayed in the 
access list.

11. Click Apply.
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Changing the owner of an object
The default owner of an object is the user who initially created the object. You can change 
an object’s owner if you are the logged-in owner of the object or a logged-in user with 
Manager access to the object. 

Note: When you change the owner of a container, only that object’s owner is changed; 
the owners of the container’s objects are not changed.

To change the owner of an object:

1. Locate the object whose owner you want to change.

2. Do one of the following:

• Click the checkbox that appears to the left of the object’s title. From the Edit 
Selected menu, select Change Owner. On the confirmation page, click 
Confirm.

• From the object’s More Actions menu, select Permissions. On the 
Permissions page, click the Change Owner button.

The Change Owner page appears.

3. Do one of the following:

• To find a specific user account, enter part of the user’s first name, last name, 
or username in the Search field. Click the Go button.

• To display all user accounts, click Show All.

• To display your favorite user accounts, click Show Favorites.

4. Select a name from the New Owner field.

5. Click Update Owner.

The Permissions page for the object appears, displaying the name of the new 
owner at the top of the access list. The new owner has Reader, Writer, and 
Manager permissions.

The name of the previous owner remains in the access list.
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Applying permissions to the objects in a 
container
When you change the access permissions of a container that includes objects, you can 
choose how to apply the container’s permissions to its contents. You can choose to apply 
all of the permissions or only the changed permissions to either the container or the 
container and its contents.

You can change a container’s access permissions if you are the logged-in owner of the 
container or a logged-in user with Manager access to it.

To apply a container’s access permission to the objects in it:

1. Locate the container whose permissions you want to change.

2. From the container’s More Actions menu, select Permissions.

The Permissions page for the container appears.

3. Make the changes you want to the access list.

4. For Options, select one of the following:

• Apply all permissions to—Assigns all of the access permissions.

• Apply only changes to—Assigns only the changed access permissions.

5. Select one of the following:

• This container only—Applies the permissions to the container only. The 
permissions of the container’s objects are not changed.

• This container and its objects, including same objects that appear in 
other containers—Applies the permissions to the container and the objects 
in it. The permissions of the same objects that appear in other containers also 
are changed.

• This container and its objects, excluding same objects that appear in 
other containers—Applies the permissions to the container and the objects 
in it. The permissions of the same objects that appear in other containers are 
not changed.

6. Click Apply.
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Applying permissions to a document and its 
versions
Since each version of a document has its own access list, when you change a document’s 
access permissions you can choose how you want to apply the changes to the 
document’s versions. You can change a document’s access permissions if you are the 
logged-in owner of the document or a logged-in user with Manager access to it.

To apply a document’s access permission to its versions:

1. Locate the document whose permissions you want to change.

2. From the document’s More Actions menu, select Permissions.

The Permissions page for the document appears.

3. Make the changes you want to the access list.

4. For Apply all permissions to, select one of the following:

• This document and its versions—Assigns the changed permissions to the 
document and all of its versions.

• This document only—Assigns the changed permissions to the document 
only. The document and its versions will have different access permissions.

5. Click Apply.
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About calendars
You can add a calendar to a collection to keep track of your appointments, meetings, and 
other activities. If you and a group of co-workers are responsible for a project, you can 
share a calendar to manage the tasks and schedules.

The entries you add to a calendar are called events. An event can occur all day or during 
a specified time period. In addition, an event can occur once or repeatedly, such as a 
weekly staff meeting or a class.

You can display a calendar in either month, week, or day view.

Month view
Month view displays an entire month with the current day highlighted. From the current 
month, you can click a link for the previous month and the next month. You can also 
display calendars for previous and following years.

The start time and title of each calendar event is shown on the date to which it was added.

Week view
Week view displays an entire week with the current day highlighted. From the current 
week, you can click a link for the previous week and the next week. You can also display 
calendars for previous and following years.

The duration, title, and owner of each event is shown on the date to which it was added. 

Day view
Day view displays the current day. From the current day, you can click a link for the 
previous day and the next day. You can also display a day from another month or year.

The day view shows the duration, title, and owner of each event added to the date. 
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Adding a calendar
You can add a calendar to a collection if you are logged in and have Writer access to the 
container. 

To add a calendar:

1. Navigate to and open the container to which you want to add a calendar.

2. From the Add menu, select Calendar.

The Add Calendar page appears.

3. In the Title field, enter a name for the calendar. The name should be short, but 
descriptive, and can contain spaces and punctuation marks.

4. Enter any optional information. Click a field name for a description of each 
property.

Note: If your administrator created custom properties, they also display on the page. See 
your administrator for information about custom properties.

5. Click Apply.

The calendar is added to the container.

To change the calendar’s access permissions, see Access permissions.
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Changing the calendar view
When viewing a calendar, you can change among the three views.

To change the calendar view:

1. Locate the calendar.

2. From the View menu, select either Month View, Week View, or Day View.
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Viewing and changing calendar properties
You do not need to be logged into DocuShare to view a calendar’s properties. However, 
only the logged-in owner of a calendar or a logged-in user with Writer access to the 
calendar can change the calendar’s properties.

To view and change a calendar’s properties:

1. Locate the calendar whose properties you want to view and change.

2. Do one of the following:

• If the calendar is open, click the Properties icon in the upper-right corner of 
the window.

• If the calendar is not open (you can view its title in a container), click the 
Properties icon that appears to the right of the calendar’s title.

The View Properties page appears. 

3. Click the Edit link.

4. Change the properties you want. Click a field name for a description of each 
property.

Note: If your administrator created custom properties, they also display on the page. See 
your administrator for information about custom properties.

5. Click Apply.
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Changing the location of a calendar
You can move a calendar to another container or have the calendar appear in several 
containers on your site. Although a calendar can appear in several containers, there is 
only one copy of it, which saves space on your DocuShare site.

To change a calendar’s location, you must be logged in and have Writer access to both 
the calendar and the new container.

Note: You can also use the Copy, Cut, and Paste commands from the Edit Selected 
menu to change the location of a calendar. See Editing multiple objects in a 
collection on page 3–7.

To change a calendar’s location:

1. Locate the calendar whose location you want to change.

2. Do one of the following:

• Click the checkbox that appears next to the calendar’s title. From the Edit 
Selected menu, select Change Location. On the Confirm Change Location 
page, click Confirm.

• Click the Properties icon that appears to the right of the calendar’s title. On 
the View Properties page for the calendar, click the Locations link.

The Change Location page appears.

3. In the Sort By field, select Title to display the possible containers in alphabetical 
order or select Handle to display the possible containers in numerical order.

4. Do one of the following:

• To find specific containers, enter any part of a container title in the Search 
field. Click the Go button.

• To display all containers, click Show All.

• To display your favorite containers, click Show Favorites.

5. In the Possible Locations field, select the container(s) in which you want the 
calendar to appear and click the Add button. To select multiple containers, use 
the CTRL key (Windows) or the Command key (Macintosh).

6. In the Selected Locations field, select any containers in which you do not want 
the calendar to appear and click the Remove button. To select multiple 
containers, use the CTRL key (Windows) or the Command key (Macintosh).

Note: Make sure at least one container appears in the Selected Locations field. 
Otherwise, the calendar will become orphaned, which means it will not appear in 
any container.

7. Click Update Locations.
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Deleting a calendar
You can delete a calendar if you are the logged-in owner of the calendar or a logged-in 
user with Manager access to it. When you delete a calendar, all of the events in it are also 
deleted.

If you accidentally delete a calendar, your administrator can restore it if the trashcan is 
enabled on your site. The trashcan holds deleted objects until your administrator 
expunges or restores the trashcan contents. See your administrator to restore a deleted 
calendar.

To delete a calendar:

1. Locate the calendar that you want to delete.

2. Do one of the following:

• Click the checkbox that appears next to the calendar’s title. From the Edit 
Selected menu, select Delete.

• From the calendar’s More Actions menu, select Delete.

The Confirm Delete page appears.

Note: If a minus sign appears in the checkbox that precedes the calendar, then you do 
not have Manager access to the object and cannot delete it.

3. Click Delete to remove the calendar from your site.

If you do not want to delete the calendar, click Cancel.
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Adding an event to a calendar
You can add an event to a calendar if you are logged in and have Writer access to the 
calendar. You can set the event so that it occurs on a regular basis, such as every Monday 
or every two weeks. 

To add a calendar event:

1. Open the calendar to which you want to add an event.

2. Do one of the following:

• Click the Add Event icon corresponding to the date on which you want to add 
the event.

• From the Add menu, select Event.

Note: If your administrator created a custom event, it appears in the Add menu.

3. In the Title field, enter a name for the event.

4. Optionally, enter a description of the event in the Description field.

5. Optionally, enter the date on which the event is to occur in the Date field.

6. For Time, do one of the following:

• Select No Time if the event is to occur all day.

• Select the beginning and ending times if the event is to occur during a 
specified time period. Be sure to select am or pm as appropriate.

7. If the event is to occur on a regular basis, select the Repeat frequency and 
number of occurrences.

8. For Initial Permissions, select one of the following:

• Same as container assigns the container’s access permissions to the object.

• Same as container except write restricted to owner assigns the users who 
have Reader access to the container with Reader access to the object. You 
are the only user with Writer access to the object.

• Restricted to owner assigns full access permissions only to you, the object’s 
owner.

9. Click Apply.

The event is added to the calendar.

10. You can click the event name to open it.

To change the event’s access permissions, see Access permissions.
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Viewing and changing calendar event 
properties
You can view and change the properties of a calendar event such as the title or time. If the 
event is recurring, the change is made to each event in the series. To change the 
properties, you must be the logged-in owner of the event or a logged-in user with Writer 
access to the event.

To view and change a calendar event’s properties:

1. Navigate to and open the calendar that contains the event you want to view and 
change.

2. Click the title of the event.

The View Properties page appears.

3. Click the Edit link.

4. Change the properties you want. Click a field name for a description of each 
property.

5. Click Apply.
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Changing the location of a calendar event
You can move an event to another calendar or have it appear in several calenders. To 
move an event, you must be logged in and have Writer access to both the event and the 
new calendar.

Although an event can appear in several calendars, there is only one copy of it, which 
saves space on your DocuShare site.

To change the location of a calendar event:

1. Navigate to and open the calendar that contains the event you want to move.

2. Click the title of the event.

The View Properties page appears.

3. Click the Locations link.

The Locations page appears, showing the event’s current location(s).

4. In the Sort By field, select Title to display the possible locations in alphabetical 
order or select Handle to display the possible locations in numerical order.

5. Do one of the following:

• To find specific calendars, enter any part of a calendar title in the Search field. 
Click the Go button.

• To display all calendars, click Show All.

• To display your favorite calendars, click Show Favorites.

6. In the Possible Locations field, select the calendar(s) in which you want the 
event to appear and click the Add button. To select multiple calendars, use the 
CTRL key (Windows) or the Command key (Macintosh).

7. In the Selected Locations field, select any calendars in which you do not want 
the event to appear and click the Remove button. To select multiple calendars, 
use the CTRL key (Windows) or the Command key (Macintosh).

Note: Make sure at least one calendar appears in the Selected Locations field. 
Otherwise, the event will become orphaned, which means it will not appear in any 
calendar.

8. Click Update Locations.



DocuShare calendars Deleting a calendar event

User Guide  6–11

 
 

Deleting a calendar event
You can delete a calendar event if you are the logged-in owner of the event or a logged-in 
user with Manager access to it. However, if the event is one of a recurring series, you 
need only Writer access to the event to delete it.

To delete a calendar event:

1. Navigate to and open the calendar that contains the event you want to delete.

2. Click the title of the event.

The View Properties page appears.

3. Click the event’s Delete icon.

4. On the Confirm Delete page, do one of the following:

• If the event is a single occurrence, click the Delete button.

• If the event occurs more than once, click the Delete All Events in This 
Series button to delete all occurrences of the event from the calendar; click 
the Delete Just This Event button to delete the event from the date you 
selected.

Note: Your administrator can restore a deleted non-recurring single event or a deleted 
recurring event series. However, your administrator cannot restore a single event 
that was deleted from a recurring event series.
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About discussions
To facilitate an online exchange of ideas, DocuShare supports threaded discussions. You 
can add a container, called a discussion, in which users add topics for other users to read 
and reply to. As users reply to a topic, their responses are sequentially linked, or threaded, 
to the original topic. Users can read or reply to any of the topics or replies in a thread.
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Adding a discussion
You can add a discussion to a collection if you are logged in and have Writer access to the 
container. 

To add a discussion:

1. Navigate to and open the container to which you want to add a discussion.

2. From the Add menu, select Discussion.

The Add Discussion page appears.

3. In the Title field, enter a name for the discussion. The name should be short, but 
descriptive, and can contain spaces and punctuation marks.

4. In the Topics Expire In field, select the length of time to retain topics and their 
message threads in the discussion after they are added.

When a topic becomes older than the duration you select, it no longer appears in 
the discussion. You can view and delete expired topics on the discussion’s View 
Expired page.

5. Enter any optional information. Click a field name for a description of each 
property.

Note: If your administrator created custom properties, they also display on the page. See 
your administrator for information about custom properties.

6. Click Apply.

The discussion is added to the container.

To change the discussion’s access permissions, see Access permissions.



Viewing and changing discussion properties DocuShare discussions

7–4  User Guide

 
 

Viewing and changing discussion properties
You do not need to be logged into DocuShare to view a discussion’s properties. However, 
only the logged-in owner of a discussion or a logged-in user with Writer access to the 
discussion can change the properties.

To view and change a discussion’s properties:

1. Locate the discussion whose properties you want to view and change.

2. Do one of the following:

• If the discussion is open, click the Properties icon in the upper-right corner of 
the window.

• If the discussion is not open (you can view its title in a container), click the 
Properties icon that appears to the right of the discussion’s title.

The View Properties page appears.

3. Click the Edit link.

4. Change the properties you want. Click a field name for a description of each 
property.

Note: If your administrator created custom properties, they also display on the page. See 
your administrator for information about custom properties.

5. Click Apply.
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Changing the location of a discussion
You can move a discussion to another container or have the discussion appear in several 
containers on your site. Although a discussion can appear in several containers, there is 
only one copy of it, which saves space on your DocuShare site.

To change a discussion’s location, you must be logged in and have Writer access to both 
the discussion and the new container.

Note: You can also use the Copy, Cut, and Paste commands from the Edit Selected 
menu to change the location of a discussion. See Editing multiple objects in a 
collection on page 3–7.

To change a discussion’s location:

1. Locate the discussion whose location you want to change.

2. Do one of the following:

• Click the checkbox that appears to the left of the discussion’s title. From the 
Edit Selected menu, select Change Location. On the Confirm Change 
Location page, click Confirm.

• Click the Properties icon that appears to the right of the discussion’s title. 
Click the Locations link.

The Change Location page appears.

3. In the Sort By field, select Title to display the possible containers in alphabetical 
order or select Handle to display the possible containers in numerical order.

4. Do one of the following:

• To find specific containers, enter any part of a container title in the Search 
field. Click the Go button.

• To display all containers, click Show All.

• To display your favorite containers, click Show Favorites.

5. In the Possible Locations field, select the container(s) in which you want the 
discussion to appear and click the Add button. To select multiple containers, use 
the CTRL key (Windows) or the Command key (Macintosh).

6. In the Selected Locations field, select any containers in which you do not want 
the discussion to appear and click the Remove button. To select multiple 
containers, use the CTRL key (Windows) or the Command key (Macintosh).

Note: Make sure at least one container appears in the Selected Locations field. 
Otherwise, the discussion will become orphaned, which means it will not appear in 
any container.

7. Click Update Locations.
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Deleting a discussion
You can delete a discussion on your DocuShare site if you are the logged-in owner of the 
discussion or have Manager access to it. When you delete a discussion, all of its current 
and expired topics are also deleted.

If you accidentally delete a discussion, your administrator can restore it if the trashcan is 
enabled on your site. The trashcan holds deleted objects until your administrator 
expunges or restores the trashcan contents. See your administrator to restore a deleted 
discussion.

To delete a discussion:

1. Locate the discussion that you want to delete.

2. Do one of the following:

• Click the checkbox that appears next to the discussion’s title. From the Edit 
Selected menu, select Delete.

• From the discussion’s More Actions menu, select Delete.

The Confirm Delete page appears.

Note: If a minus sign appears in the checkbox that precedes the discussion, then you do 
not have Manager access to the object and cannot delete it.

3. Click Delete to remove the discussion from your site.

If you do not want to delete the discussion, click Cancel.
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Adding a topic to a discussion
A topic is the first message added to a discussion and initiates the online conversation. 
Users can reply to the topic as well as to individual replies. By default, replies are 
indented, which provides a hierarchical display of the discussion.

You can add a topic to a discussion if you are logged in and have Writer access to the 
discussion.

To add a topic:

1. Open the discussion to which you want to add a topic.

2. Click the Add Topic button.

Note: If your administrator created a custom topic, it appears in the Add menu.

3. In the Title field, enter a name for the topic.

4. In the Description field, enter the topic message. The description appears below 
the title in a discussion. You can include HTML tags in the topic’s description.

5. Click Submit.

The topic is added to the discussion.

To change the topic’s access permissions, see Access permissions.

Adding replies
If you are logged in and have Writer access to the topic or reply, you can add a reply. 

To add a reply:

1. Navigate to and open the discussion.

2. Locate the topic or reply to which you want to reply.

3. Click the Reply button.

4. Enter a title and description.

5. If you want to include the previous message and the name of the user who added 
it, click Quote Post.

6. Click Submit.
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Viewing and changing the properties of a 
topic or reply
Any user can view the properties of a topic or reply. You can change the properties of a 
topic or reply if you are logged into DocuShare and have Writer access to the object.

To view and change the properties of a topic or reply:

1. Navigate to and open the discussion that contains the topic or reply you want to 
change.

2. Click the Properties icon that appears to the right of the object.

The View Properties page appears.

3. Click the Edit link.

4. Change the properties you want. Click a field name for a description of each 
property.

5. Click Apply.
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Changing the location of a topic
You can move a topic and its message thread to another discussion or have it appear in 
several discussions. To move a topic, you must be logged in and have Writer access to 
both the topic and the new discussion.

Although a topic can appear in several discussions, there is only one copy of it, which 
saves space on your DocuShare site.

To change the location of a topic:

1. Navigate to and open the discussion that contains the topic you want to move.

2. Click the Properties icon that appears to the right of the topic’s title.

The View Properties page appears.

3. Click the Locations link.

The Locations page appears, showing the topic’s current location(s).

4. In the Sort By field, select Title to display the possible locations in alphabetical 
order or select Handle to display the possible locations in numerical order.

5. Do one of the following:

• To find specific discussions, enter any part of a discussion title in the Search 
field. Click the Go button.

• To display all discussions, click Show All.

• To display your favorite discussions, click Show Favorites.

6. In the Possible Locations field, select the discussion(s) in which you want the 
topic to appear and click the Add button. To select multiple discussions, use the 
CTRL key (Windows) or the Command key (Macintosh).

7. In the Selected Locations field, select any discussions in which you do not want 
the topic to appear and click the Remove button. To select multiple discussions, 
use the CTRL key (Windows) or the Command key (Macintosh).

Note: Make sure at least one discussion appears in the Selected Locations field. 
Otherwise, the topic will become orphaned, which means it will not appear in any 
discussion.

8. Click Update Locations.
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Deleting a topic or reply
You can delete a topic or reply if you have Manager access to it or you are the object’s 
owner. You also must be logged into DocuShare. When you delete a topic or reply, any 
message threads also are deleted.

To delete a topic or reply: 

1. Navigate to and open the discussion that contains the topic or reply that you want 
to delete.

2. Do one of the following:

• From the object’s More Actions menu, select Delete.

• Select the checkbox that appears next to the object’s title. From the Edit 
Selected menu, select Delete.

The Confirm Delete page appears.

Note: If a minus sign appears in the checkbox that precedes the topic or reply, then you 
do not have Manager access to the object and cannot delete it.

3. On the Confirm Delete page, click the Delete button.

If you do not want to delete the object, click Cancel.
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Viewing and deleting expired topics
If you set an expiration for the topics added to a discussion, you can view and delete the 
expired topics. To delete expired topics, you must be logged in and have Manager access 
to the topics.

To view and delete expired topics:

1. Locate the discussion whose expired topics you want to view.

2. Click the Properties icon that appears to the right of the discussion’s title.

The View Properties page appears.

3. Click the View Expired link.

The page displays all of the expired topics that no longer appear on the 
discussion.

4. Do one of the following:

• Select the individual topics that you want to delete.

• Click Select All to select all of the topics.

5. Click Delete Selected.
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About URLs
A DocuShare URL is a link to a web page. Adding a URL to a collection enables you to 
easily share useful and interesting web pages with other DocuShare users and guests.
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Adding a URL
You can add a URL to a collection if you are logged in and have Writer access to the 
container.  

To add a URL:

1. Navigate to and open the container to which you want to add a URL.

2. From the Add menu, select URL.

The Add URL page appears.

3. In the URL field, enter the Internet address of the web page (for example, http://
docushare.xerox.com).

While viewing the web page in a browser, you can copy the URL from the 
Address or Location field and paste it into the URL field.

4. In the Title field, enter a name for the URL. The name should be short, but 
descriptive, and can contain spaces and punctuation marks.

5. Enter any optional information. Click a field name for a description of each 
property.

6. Click Apply.

The URL is added to the container.

To change the URL’s access permissions, see Access permissions.
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Viewing and changing URL properties
You do not need to be logged into DocuShare to view a URL’s properties. However, only 
the logged-in owner of a URL or a logged-in user with Writer access to the URL can 
change its properties.

To view and change a URL’s properties:

1. Locate the URL whose properties you want to view and change.

2. Click the Properties icon that appears to the right of the URL’s title.

The View Properties page appears. 

3. Click the Edit link.

4. Change the properties you want. Click a field name for a description of each 
property.

Note: If your administrator created custom properties, they also display on the page. See 
your administrator for information about custom properties.

5. Click Apply.
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Changing the location of a URL
You can move a URL to another container or have the URL appear in several containers 
on your site. Although a URL can appear in several containers, there is only one copy of it, 
which saves space on your DocuShare site.

To change a URL’s location, you must be logged in and have Writer access to both the 
URL and the new container.

Note: You can also use the Copy, Cut, and Paste commands from the Edit Selected 
menu to change the location of a URL. See Editing multiple objects in a collection 
on page 3–7.

To change a URL’s location:

1. Locate the URL whose location you want to change.

2. Do one of the following:

• Click the checkbox that appears to the left of the URL’s title. From the Edit 
Selected menu, select Change Location. On the Confirm Change Location 
page, click Confirm.

• Click the Properties icon that appears to the right of the URL’s title. Click the 
Locations link.

The Change Location page appears.

3. In the Sort By field, select Title to display the possible containers in alphabetical 
order or select Handle to display the possible containers in numerical order.

4. Do one of the following:

• To find specific containers, enter any part of a container title in the Search 
field. Click the Go button.

• To display all containers, click Show All.

• To display your favorite containers, click Show Favorites.

5. In the Possible Locations field, select the container(s) in which you want the 
URL to appear and click the Add button. To select multiple containers, use the 
CTRL key (Windows) or the Command key (Macintosh).

6. In the Selected Locations field, select any containers in which you do not want 
the URL to appear and click the Remove button. To select multiple containers, 
use the CTRL key (Windows) or the Command key (Macintosh).

Note: Make sure at least one container appears in the Selected Locations field. 
Otherwise, the URL will become orphaned, which means it will not appear in any 
container.

7. Click Update Locations.
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Deleting a URL
You can delete a URL on your DocuShare site if you are the logged-in owner of the URL or 
a logged-in user with Manager access to it.

If you accidentally delete a URL, your administrator can restore it if the trashcan is 
enabled on your site. The trashcan holds deleted objects until your administrator 
expunges or restores the trashcan contents. See your administrator to restore a deleted 
URL. 

To delete a URL:

1. Locate the URL that you want to delete.

2. Do one of the following:

• Click the checkbox that appears next to the URL’s title. From the Edit 
Selected menu, select Delete.

• From the URL’s More Actions menu, select Delete.

The Confirm Delete page appears.

Note: If a minus sign appears in the checkbox that precedes the URL, then you do not 
have Manager access to the object and cannot delete it.

3. Click Delete to remove the URL from your site.

If you do not want to delete the URL, click Cancel.
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About notifications
A notification allows you to receive an email message when a change occurs to a 
DocuShare object. You can add a notification for any object on your site. For example, you 
can add a notification for a document to have DocuShare email you when a new version of 
the document is uploaded. You might want to add a notification for a collection to know 
when new content is added to the collection.

You can add a notification for any of the following changes to an object:

Any change—Any change to an object.

Something added—A new object is added to a container.

New document version added—A new version of a document is uploaded.

Something deleted—The object is deleted.

Properties edited—The object’s properties are changed.

Permissions edited—The object’s permissions are changed.

Change in ownership—The object’s owner is changed.

Location edited—The object’s location is changed.

Document locked or checked out—The document is locked or checked out.

Document unlocked—The document is unlocked after being locked, but a new version of 
it was not uploaded.

Note: To use DocuShare notifications, your administrator must configure the server with 
an SMTP mail gateway for outgoing mail. Your user account properties must 
include an email address.
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Adding a notification
You can add a notification for an object if you are logged in and have Reader access to the 
object. You can quickly add a simple notification to have DocuShare email you when new 
content is added to an object, or you can choose advanced options to customize the 
notification.

To add a notification:

1. Locate the object for which you want to add a notification.

2. Do one of the following:

• Click the object’s Notifications icon.

• Click the object’s Properties icon. Then click the Notifications link.

3. On the Notifications page, click Create a New Notification.

4. In the Period field, select one of the following time periods:

• Immediate provides notification immediately after the event occurs.

• Daily provides notification in a daily summary report.

• Weekly provides notification in a weekly summary report.

5. To select advanced options, click Show Advanced Options and choose from the 
following:

Events of Interest—The event or events of which you want to be notified. To 
select multiple events, use the CTRL key (Windows) or the Command key 
(Macintosh).

Include Recipient Activity—Specifies whether or not to also notify the user 
whose action caused the notification. Select Yes to notify the user; otherwise, 
select No.

Sender—The username that appears in the email message From field: Admin or 
Owner.

Notification Applies To—If the object is a collection, specifies how to apply the 
notification to the collection and the objects in it.

Initial Permissions—Specifies the permissions for the notification.

6. Click Apply.

The notification does not appear as an object in a container. Notifications appear on the 
object’s Notifications page.

Note: If you are receiving too many email messages from notifications, you can choose to 
not receive messages for one or more types of events for all of your notifications. 
Click your username on the navigation bar and use the Suppress Notification 
Messages menu on the Edit page to turn off the events you want. 
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Viewing notifications
You must be logged into DocuShare and have Reader access to the object to view its 
notifications.

To view an object’s notifications:

1. Locate the object whose notifications you want to view.

2. Do one of the following:

• Click the object’s Notifications icon.

• Click the object’s Properties icon. Then click the Notifications link.

The object’s current notifications display.
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Creating a recipient list for a notification
You can create a recipient list for a notification to have DocuShare notify others when a 
change occurs to an object. For example, you may want co-workers to know when a new 
version of a document is uploaded or when an object is moved to another location.

You must be the logged-in owner of a notification or a logged-in user with Writer access to 
the notification to create a recipient list.

To create a recipient list for a notification:

1. Locate the object that has the notification for which you want to create a recipient 
list.

2. Do one of the following:

• Click the object’s Notifications icon.

• Click the object’s Properties icon. Then click the Notifications link.

The object’s current notifications display.

3. Click the Properties icon that appears to the right of the notification you want to 
change.

The View Properties page appears.

4. Click the Recipients link.

5. Click Change Recipients.

6. In the Show field, select the type of account you want to display in the Possible 
Users/Groups field.

7. Do one of the following:

• To find a specific account, enter part of the user’s first name, last name, or 
username or the group’s title in the Search field. Click the Go button.

• To display all accounts, click Show All.

• To display your favorite accounts, click Show Favorites.

8. In the Possible Users/Groups field, select the accounts to add to the recipient list 
and click the Add button. To select multiple accounts, use the CTRL key 
(Windows) or the Command key (Macintosh).

9. In the Selected Users/Groups field, select any accounts that you want to remove 
from the recipient list and click the Remove button. To select multiple accounts, 
use the CTRL key (Windows) or the Command key (Macintosh).

10. Click Update.
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Viewing and changing notification properties
To view an object’s notification properties, you must be logged-in and have Reader access 
to the object. You must be the logged-in owner of a notification or a logged-in user with 
Writer access to the notification to change the notification’s properties.

To view and change an object’s notification properties:

1. Locate the object whose notification properties you want to view and change.

2. Do one of the following:

• Click the object’s Notifications icon.

• Click the object’s Properties icon. Then click the Notifications link.

The object’s current notifications display.

3. Click the Properties icon that appears to the right of the notification you want to 
change.

The View Properties page appears.

4. Click the Edit link.

5. Change the properties you want. Click a field name for a description of each 
property.

6. Click Apply. 
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Deleting a notification
You can delete a notification if you are the logged-in owner of a notification or a logged-in 
user with Manager access to the notification.

If you accidentally delete a notification, your administrator can restore it if the trashcan is 
enabled on your site. The trashcan holds deleted objects until your administrator 
expunges or restores the trashcan contents. See your administrator to restore a deleted 
notification.

To delete a notification:

1. Locate the object whose notification you want to delete.

2. Do one of the following:

• Click the object’s Notifications icon.

• Click the object’s Properties icon. Then click the Notifications link.

The object’s current notifications display.

3. Click the Properties icon that appears to the right of the notification you want to 
delete.

The View Properties page appears.

4. Click the Delete icon.

The Confirm Delete page appears.

5. Click Delete.
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About searches
DocuShare search features enable you to quickly find objects on your site. You can 
perform simple word searches by having DocuShare find the objects that contain the text 
you specify. You also can combine several search terms to find specific objects, such as 
all documents authored by one user that contain the word DocuShare in their titles. When 
searching for objects, you can choose the scope of a search.

When an object is added to a container, DocuShare indexes and stores in a database the 
object’s properties (also called metadata) and, if the object is a document, its content. A 
search checks the database to find the objects that match your search terms. In addition, 
DocuShare uses a process called stemming to find objects that contain variations of the 
word you specify. For example, a search for the word mouse will find the word mice.



DocuShare searches Viewing new content on your site

User Guide  10–3

 
 

Viewing new content on your site
From any page, you can display a list of the content that has been added or changed on 
your site. This lets you quickly find any new or recently changed object or content that 
might be of interest to you.

To find out what’s new:

1. Do one of the following:

• From the home page, select the time period you want under What’s New. 
Click Go.

• On the navigation bar, click What’s New.

DocuShare displays the list of content that has been added or changed.

2. To change the search query used to display the list of new or changed content, 
click the Refine Query link.

The Refine Search page appears.

3. Change any of the search properties and click the Search button. Click a field 
name for a description of the property, or see Running an advanced search on 
page 10–6.

Note: If you are a guest user and you click What’s New on the navigation bar, 
DocuShare lists the content that has been added or changed during the past 24 
hours. If you are a logged-in user and you click What’s New on the navigation bar, 
DocuShare lists the content that has been added or changed since you last clicked 
What’s New.
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Searching for objects
The navigation bar provides a search area that lets you quickly search for objects and 
content. You do not need to be logged into DocuShare to run a search.

To run a quick search:

1. On the navigation bar, enter one or more words in the Search field. Separate 
each word with a space. 

Note: If you want DocuShare to search for an exact phrase or a phrase that includes a 
logical operator such as And or Or, enclose the phrase in quotation marks (for 
example, “war and peace”).

If you want the search results to exclude objects that contain a word, precede that 
word with a minus sign (-). For example, if you want to find content on green 
vegetables but not broccoli, enter green vegetables -broccoli.

If you want the search results to include objects that contain a word, precede that 
word with a plus sign (+). For example, if you want to find content on green 
vegetables that definitely includes broccoli, enter green vegetables +broccoli.

2. Depending on the page from which you are running the search and whether or not 
your site is part of a federation, select a search scope from the In menu.

3. Click Search.

DocuShare displays the search results. For documents, DocuShare either 
provides a snippet of the document content with the search term highlighted or 
displays the document’s abstract if the search term is not found in the content. 
You can click the Show/Hide Details button to control this display. 

If you searched all federated sites, DocuShare displays the search results from 
the site on which you ran the search. To display the results from the other sites in 
the federation, click each site name under Select a Federation Site.
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Search options
When running a quick search, you can specify several options to narrow the search and to 
control how the search results are displayed.

To run a quick search using search options:

1. Enter the search words in the Search field and, if the In field appears, select the 
search scope.

2. Click the small triangle next to the Search field and specify any of the following 
information:

Search Text Contained In—Specifies the location of the search words. Any Text 
searches the object’s content and properties.

Last Modified—Limits the search to objects that were last changed within a 
specific time period.

Object Types—Specifies the type of objects to search.

Document Types—Searches for all types of documents or a specific type. The 
Object Types must be set to All Object Types or Documents Only.

Maximum Results—The maximum number of objects to display in the search 
results list. DocuShare orders the results by displaying the most relevant objects 
first.

Sort Results—The order in which to display the search results.

3. Click Search.

DocuShare displays the search results.
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Running an advanced search
Using the Advanced Search page, you can further narrow a search by combining search 
terms, specify ranges, and search for specific objects and documents.

To run an advanced search:

1. On the navigation bar, click the Advanced link.

2. Depending on the page from which you are running the search and whether or not 
your site is part of a federation, select a search scope from the Search Within 
menu.

3. In the Maximum Results field, select the maximum number of objects to display 
in the search results list. DocuShare orders the results by displaying the most 
relevant objects first.

4. In the Sort Results field, select the order in which to display the search results.

5. Under Search Text Contained In, enter the search term. Create a search term by 
selecting where the search words should occur, selecting an operator, and then 
entering the search word or words (separate each word with a space). If you want 
DocuShare to search for an exact phrase or a phrase that includes a logical 
operator, enclose the phrase in quotation marks (for example, “war and peace”).

You can click + add search term to create another search term using a logical 
operator. See Table 10–1 for a description of each logical operator.

Note: For information on how to use wildcard and nonalphanumeric characters in a 
search term, see Using reserved characters in a search on page 10–9.

6. Under Limit Search to Date Range, enter the date range to use when searching 
for objects. Create a date range by selecting options from the menus and entering 
a date.

You can click + add date range to create a second date range.

7. Under Find Results with Numeric Range, enter the numeric range to use when 
searching for objects whose properties have numeric values.

You can click + add numeric range to create a second numeric range.

Note: This field appears if an object has a numeric property that is searchable.

8. Under Object Types to Search, do one of the following

• To search all of the objects on the site, click Search all object types.

• To search specific objects only, click Limit search to selected object types 
and select the objects to search from the list.
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9. If you searching all object types or documents only, under Document Types to 
Search, do one of the following

• To search all types of documents, click Search all document types.

• To search specific types of documents, click Limit search to selected 
document types and select the types of documents to search from the list. 
Each document type is specified by its MIME type.

10. Click the Search button. 

DocuShare displays the search results. For documents, DocuShare either 
provides a snippet of the document content with the search term highlighted or 
displays the document’s abstract if the search term is not found in the content. 
You can click the Show/Hide Details button to control this display.

If you searched all federated sites, DocuShare displays the search results from 
the site on which you ran the search. To display the results from the other sites in 
the federation, click each site name under Select a Federation Site. 

Table 10–1: Logical operators

Logical operator Meaning

And Searches for objects that contain all of the search 
terms. 

For example: Search for objects where “Title contains 
Training And Summary contains Basic Product.”

The search would return only objects that have the word 
“Training” in the Title, and the phrase “Basic Product” in 
the Summary.

Or Searches for objects that contain one of the search 
terms. 

For example: Search for objects where “Title contains 
Advanced Or Summary contains Administrator.”

The search would return objects that have either the word 
“Advanced” in the Title or the word “Administrator” in the 
Summary, or both the word “Advanced” in the Title and 
“Administrator” in the Summary.

Accrue Searches for objects that contain at least one of the 
search terms, and relevance ranks the results by 
displaying the objects that contain the largest number 
of search terms first.

For example: Search objects where “Title contains 
Advanced Accrue Summary contains Administrator.”

The search would first return objects that have both 
Advanced in the Title and Administrator in the Summary, 
then objects that contain just one of the search terms 
(either Advanced in the Title or Administrator in the 
Summary).
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And Not Searches for objects that contain one search term and 
not the other.

For example: Search objects where “Title contains 
Technology And Not Title contains Marketing.”

The search would return only those objects where 
Technology was in the Title, but not return objects if 
Marketing was also in the Title.

Table 10–1: Logical operators

Logical operator Meaning
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Using reserved characters in a search
You can use these wildcard characters when building a search:

Question mark ?—Specifies any single alphanumerical character.
For example: ?an returns ban, can, dan, fan, etc.

Asterisk *—Specifies any number of alphanumerical characters.
For example: corp* returns corporate, corporation, corporal, corpulent, etc.

Note: To find objects that include a wildcard character, select the specific property name, 
use the equals operator, and precede the character with two backslashes (\\). For 
example, to search for a document named *ReadFirst enter: Title equals 
\\*ReadFirst.

To find objects that include nonalphanumeric characters, such as at signs (@) and equal 
signs (=), or nonalphanumeric and wildcard characters, select the specific property name, 
use the equals operator, and enclose the search text within single quotation marks.

Example: To search for jbrown@mycompany.com, enter:

(User) Email Address equals ‘jbrown@mycompany.com’

Example: To search for jbrown@* enter:

(User) Email Address equals ‘jbrown@*’

Note: Three nonalphanumeric characters, the ampersand (&), dash (-), and underscore 
(_), are considered alphanumeric characters and do not require any special 
treatment. For example, to search for my_document.doc, enter 
my_document.doc.
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Saving a search query
After running an advanced search, you can save the search query so you can run the 
same search again at a later time or share it with other users. To save a search query, you 
must be logged in.

To save the query used in a search:

1. Define your search terms and run a search.

The search results display.

2. From the Add menu, select Saved Query.

The Add Saved Query page appears.

3. In the Title field, enter a title for the saved query.

4. Enter any optional information. Click a field name for a description of each 
property. 

5. Click Save Search.

The Locations page appears.

6. Do one of the following:

• To find specific containers, enter any part of a container title in the Search 
field. Click the Go button.

• To display all containers, click Show All.

• To display your favorite containers, click Show Favorites.

7. In the Possible Locations field, select the container(s) in which you want the 
saved query to appear and click the Add button. To select multiple containers, use 
the CTRL key (Windows) or the Command key (Macintosh).

8. In the Selected Locations field, select any containers in which you do not want 
the saved query to appear and click the Remove button. To select multiple 
containers, use the CTRL key (Windows) or the Command key (Macintosh).

9. Click Update Locations.

DocuShare adds your search query to the container. When you click the saved 
query, DocuShare runs the search using the saved search terms and displays the 
results.
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Changing saved query properties
You can change the properties and search terms of a saved query if you are the logged-in 
owner of the query, or you are logged in and have Writer access to it.

To change a saved query’s properties:

1. Locate the saved query whose properties you want to change.

2. Click the Properties icon that appears to the right of the saved query’s title.

The View Properties page appears. 

3. Click the Edit link.

4. Change the properties you want.

5. Click Apply.

6. Click the Edit Query link.

7. Change the search terms you want.

8. Click Apply.

DocuShare saves the changes to the saved query.
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Changing the location of a saved query
You can move a saved query to another container or have the saved query appear in 
several containers on your site. Although a saved query can appear in several containers, 
there is only one copy of it, which saves space on your DocuShare site.

To change a saved query’s location, you must be logged in and have Writer access to both 
the saved query and the new container.

Note: You can also use the Copy, Cut, and Paste commands to change the location of a 
saved query. See Editing multiple objects in a collection on page 3–7.

To change a saved query’s location:

1. Locate the saved query whose location you want to change.

2. Do one of the following:

• Click the checkbox that appears to the left of the saved query’s title. From the 
Edit Selected menu, select Change Location. On the Confirm Change 
Location page, click Confirm.

• Click the Properties icon that appears to the right of the saved query’s title. 
Click the Locations link.

3. In the Sort By field, select Title to display the possible containers in alphabetical 
order or select Handle to display the possible containers in numerical order.

4. Do one of the following:

• To find specific containers, enter any part of a container title in the Search 
field. Click the Go button.

• To display all containers, click Show All.

• To display your favorite containers, click Show Favorites.

5. In the Possible Locations field, select the container(s) in which you want the 
saved query to appear and click the Add button. To select multiple containers, use 
the CTRL key (Windows) or the Command key (Macintosh).

6. In the Selected Locations field, select any containers in which you do not want 
the saved query to appear and click the Remove button. To select multiple 
containers, use the CTRL key (Windows) or the Command key (Macintosh).

Note: Make sure at least one container appears in the Selected Locations field. 
Otherwise, the saved query will become orphaned, which means it will not appear 
in any container.

7. Click Update Locations.
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Deleting a saved query
You can delete a saved query if you are the logged-in owner of the query or a logged-in 
user with Manager access to it.

If you accidentally delete a saved query, your administrator can restore it if the trashcan is 
enabled on your site. The trashcan holds deleted objects until your administrator 
expunges or restores the trashcan contents. See your administrator to restore a deleted 
saved query.

To delete a saved query:

1. Locate the saved query that you want to delete.

2. Do one of the following:

• Click the checkbox that appears next to the saved query’s title. From the Edit 
Selected menu, select Delete.

• Click the Properties icon that appears to the right of the saved query’s title. 
On the View Properties page for the saved query, click the Delete button.

The Confirm Delete page appears.

3. Click Delete to remove the saved query from your site.

If you do not want to delete the saved query, click Cancel.
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About My DocuShare
My DocuShare lets you easily manage personal content from a single page. Your personal 
collection, favorite calendars, favorite objects, browsing history, groups, and routing tasks 
as well as the top level site collections appear in areas called portlets on My DocuShare. 

After logging into DocuShare, a link to My DocuShare appears on the site home page and 
on the navigation bar. The figure below shows a My DocuShare page. You can close a 
portlet and reopen it by clicking the small triangle next to the portlet title.
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Managing favorites
To conveniently access frequently used objects from a single location, you can add them 
to your favorites. Any object you add as a favorite is a link to the original object, not a copy. 
If the original object is deleted, it will no longer appear in your favorites.

To add an object to your favorites:

1. Locate the object that you want to add to favorites.

2. Do one of the following:

• Click the object’s Add to Favorites icon.

• Click the checkbox that appears next to the object’s title. From the Edit 
Selected menu, select Add to Favorites.

3. On the Confirm Add to Favorites page, click Confirm.

4. On the navigation bar, click My DocuShare.

The object you added appears under Favorites. The View menu lets you display 
one type of favorite object, such as favorite documents. You can click the 
Favorites heading to display your favorites in a collection listing. In this view you 
can use standard collection features.

To remove an object from your favorites:

1. Open My DocuShare.

2. Click the Favorites heading.

3. From the Edit Selected menu, select Remove Favorite.

4. On the Confirm Remove from Favorites page, click Confirm.

The object no longer appears in favorites. However, the object still appears in its 
original location(s).
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Using your personal collection
Your personal collection on My DocuShare is a private repository for your objects. By 
default, only you and a group of administrators called Content Administrators have full 
access to the collection.

To add an object to your personal collection:

1. Open My DocuShare.

2. Click the Personal Collection heading.

3. From the Add menu, select the type of object you want to add.

4. On the Add page, enter the required information and click Apply.

5. On the navigation bar, click My DocuShare.

The object you added appears under Personal Collection. The View menu lets 
you display one type of object, such as documents.

Note: You also can add an object to your personal collection using an object’s Locations 
page. Display and select you personal collection in the Possible Locations field 
and then click the Add and Update Locations buttons.

To view your personal collection in full page:

1. Open My DocuShare.

2. Click the Personal Collection heading.

The objects display in a collection listing. In this view you can use standard 
collection features such as adding new objects and changing the collection’s 
properties.

Note: You can delete your personal collection and, optionally, its contents. However, the 
next time you access My DocuShare your personal collection appears.
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Using your personal calendar
Your personal calendar is a combination of all your favorite calendars. This allows you to 
merge the events from separate calendars into a master calendar. For example, you can 
add individual vacation calendars to your favorites to create a single vacation calendar for 
a group.

To create a personal calendar:

1. Locate the calendar that you want to add to favorites.

2. Do one of the following:

• Click the calendar’s Add to Favorites icon.

• Click the checkbox that appears next to the calendar’s title. From the Edit 
Selected menu, select Add to Favorites.

3. On the Confirm Add to Favorites page, click Confirm.

4. Repeat steps 1 through 3 to add additional calendars to favorites.

5. On the navigation bar, click My DocuShare.

The single, personal calendar appears under Favorite Calendars.

6. Using the View menu, you can switch between daily and weekly views of the 
calendar.
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Viewing your browsing history
Under the History heading, you can view the twenty most recent DocuShare pages you 
have visited while logged into DocuShare. Each page is linked, allowing you to click it to 
go to that page. Your browsing history restarts each time you log into DocuShare.

Viewing your groups
All of the groups of which you are a member display under the Groups heading. You can 
click a group name to display its Properties page.
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Viewing your routing tasks
All of the routing tasks assigned to you are listed under the Tasks heading. This provides 
you with a quick view of the tasks to which you need to respond. You can click a task to 
open its window.

In addition, clicking the Tasks heading displays the My Tasks window. You can view both 
the tasks assigned to you and the tasks you assigned, and your routing task history in this 
window. For more information on document routing, see Routing documents.
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About routing documents
During a document’s development cycle, you often need to solicit feedback from others, 
receive approval of the document’s content, or simply share the information in the 
document. DocuShare enables you to automate the routing of documents to users and 
request a specific action after the users receive the documents.

On a form called a Routing Slip, you indicate the users to whom the document should be 
sent, the type of action you want the users to take, and a message describing the 
document task. You then submit the Routing Slip; DocuShare notifies the specified users 
of the document task. While a task is in progress, you can monitor its status.
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Routing a document
You can route an existing document on your site or you can choose to route a document 
when adding it to DocuShare. In addition, you can route an individual document version. 
On the Routing Slip that accompanies the document, you can request users to approve 
the document, review the document and provide changes, or acknowledge receipt of the 
document, or you can provide the document for information only.

When creating a routing task, you can define a single routing step or several sequential 
steps. A single routing step consists of one type of action, such as sending a document to 
users for approval. A multi-step routing task enables you to automate a document 
process. For example, you can create a routing task to send a document to a group of 
users for their review and comment before sending the revised document for approval.

To route a document:

1. Do one of the following:

• To route a single document, locate the document or document version that 
you want to route and click its Route icon. A Route icon does not appear if 
the document is locked.

• To route several documents, locate the documents and click the checkbox 
next to each document. From the Edit Selected menu, select Route. On the 
Confirmation page, click Confirm.

• To route a document after adding it to DocuShare, select Document from 
the Add menu. Enter the required information and click Publish and then 
route the document before clicking Apply.

• To route a document before it appears in DocuShare, select Document 
from the Add menu. Enter the required information and click Route the 
document and publish it later before clicking Apply.

The Route Document window appears.

2. If you want to use a saved Routing Slip, do one of the following and then go to 
step 18: 

• Select one of your saved Routing Slips and click Load.

• Click All Saved Routing Slips to display the public Routing Slips saved by all 
site users. Select a Routing Slip.

3. Under Routing Action, choose one of the following:

• Approve or Disapprove—Requires users to approve or not approve the 
document.

• Review and Make Changes—Allows users to provide comments and a 
revised version of the document. Click Share Changes with Recipients if 
you want each recipient to see the previous recipient’s changes.

• Acknowledge Receipt—Provides the document to users for information and 
requires the users to confirm receiving the document.

• Information—Provides the document to users for information only.
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4. Depending on the routing action you selected, choose one of the following 
Routing Orders:

• In Order—Routes the document to users in the order in which they are listed 
in the Selected Users/Groups field. If a user does not approve the 
document, it is not routed to subsequent users.

• At the Same Time-Single Reply—Routes the document to all users 
simultaneously and only one user’s reply is needed to complete the routing 
task.

• At the Same Time-All Reply—Routes the document to all users 
simultaneously and all users must reply to complete the routing task.

• At the Same Time-Majority Reply—Routes the document to all users 
simultaneously and more than half of the users must reply to complete the 
routing task.

5. Under Message, do the following:

• In the Subject field, enter a brief topic that appears in the notification or email 
that the user receives.

• In the Comments field, enter a message.

6. Click Next to go to the Add Recipients page.

7. In the Show field, select the type of account you want to display in the Possible 
Users/Groups field.

8. Do one of the following:

• To find a specific account, enter part of the user’s first name, last name, or 
username or the group’s title in the Search field. Click the Go button.

• To display all accounts, click Show All.

• To display your favorite accounts, click Show Favorites.

9. In the Possible Users/Groups field, select the accounts to add to the list of 
recipients and click the Add button. To select multiple accounts, use the CTRL 
key (Windows) or the Command key (Macintosh).

10. In the Selected Users/Groups field, select any accounts that you want to remove 
from the list of recipients and click the Remove button.

11. To show the members in a group, select the group in the Selected Users/Groups 
field and click Show Group Members. The group members replace the group title 
and the routing task is sent to each user and not to the group.

12. To reorder the recipients in the Selected Users/Groups field, select an account 
and do one of the following:

• To move the recipient before another recipient, click Move Up.

• To move the recipient after another recipient, click Move Down.

13. Click Next to go to the Choose Escalation and Notification page.

14. Under Escalation, choose any of the following:

• If Not Completed By—Specifies a completion date for the routing task. Either 
enter a date in the field or click the Calendar icon and select a date.
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• Then Escalate—If the routing task is not complete by the specified date, 
choose the type of action you want to take.

15. Under Notify Me, choose any of the following:

• Of Escalation—Notifies you of the escalation action.

• Of Task Progress—Notifies you of the routing status after each user action.

• When Task Is Complete—Notifies you when each routing step is complete.

To check for notifications, click the My Tasks link on the navigation bar and select 
Tasks Assigned to Me.

16. Click Done and review the routing information for the task on the Routing 
Summary page.

17. To save the Routing Slip, click Save Routing Slip. Enter a name for the Routing 
Slip and keep Save as private selected if you do not want to share the Routing 
Slip with other users. Then click OK.

18. Do one of the following:

• To add another document to the Routing Slip before submitting the task, see 
Adding documents to the Routing Slip on page 12–5.

• Click Submit to start the routing task.

• Click Back to change any of the routing information.

• Click Add Step to add another step to the routing task.

Note: If you chose Route the document and publish it later in step 1, you must publish 
the document for it appear in DocuShare. For information on how to publish the 
document, see Checking the status of routing tasks you assigned on page 12–7.

Adding documents to the Routing Slip
Before submitting a Routing Slip, you can include additional documents to be routed using 
the following procedure.

To add a document to a Routing Slip:

1. Do one of the following:

• Locate the document that you want to route and click its Route icon.

• In an Add Document window, enter the document filename and title, and then 
select either Route the document and publish it later or Publish and then 
route the document.

2. In the confirmation window, click OK.

The document you added appears on the Routing Slip’s Routing Summary page. 
On the Routing Summary page, you can remove a document from the Routing 
Slip by selecting the document and clicking the Remove button.
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Setting up a collection for routing documents
You can have any document added to a collection automatically routed by associating a 
Routing Slip with the collection. Provided either a private or a public saved Routing Slip is 
available, then you can associate the Routing Slip with the collection.

To use a Routing Slip with a collection:

1. Locate the collection you want to use for routing documents.

2. Click the Properties icon that appears to the right of the collection’s title.

3. Click the Edit link.

4. In the Route Before Publishing field, do one of the following:

• Select Yes to route the document before it is added to the collection. You 
must select a Routing Slip in step 5.

• Select No to add the document and then route it.

5. In the Use Routing Slip field, select the Routing Slip that you want to use.

6. Click Apply.
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Checking the status of routing tasks you 
assigned
You can check the status of completed and pending routing tasks that you assigned to 
other users. Once a task is complete, you can choose to delete it, keep a record of it, or 
publish the document to add it to DocuShare.

To check the status of a routing task:

1. Do one of the following:

• On the navigation bar, click My Tasks.

• On the navigation bar, click My DocuShare. Then click Tasks.

The My Tasks window appears.

2. From the Show menu, select Tasks Assigned by Me.

The page lists the routing tasks, under Description, the date the task began, and 
the status. Table 12–1 describes the status information.

Table 12–1: Task status

Status Description

Approved The single-step task or one step of a multi-step task is 
complete and the recipient(s) approved the document(s).

Disapproved The single-step task or one step of a multi-step task is 
complete and the recipient(s) did not approve the 
document(s).

Reviewed The single-step task or one step of a multi-step task is 
complete and the recipient(s) reviewed the document(s).

Acknowledged The single-step task or one step of a multi-step task is 
complete and the recipient(s) acknowledged receiving the 
document(s).

Delivered The single-step task or one step of a multi-step task is 
complete and the recipient(s) received the document(s) for 
their information.

All Steps Completed The multi-step task is complete.

Started The task is pending. It is currently being routed to all 
recipients at the same time for approval, review, or 
acknowledgement.

Username The task is pending. It is currently being routed to all 
recipients in order; the user whose name is displayed has 
received the document, but has not taken any action.

Step # The task is pending and is on a specific step of a multi-
step task.
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3. To view more information about the task, click the task’s description.

A Report on Routing window appears, which shows the status of each user 
assigned the task.

4. Do one of the following:

• To view an individual recipient’s comments, click the user’s name.

• To view all recipient comments, click Show all User Comments. If you want, 
you can save the comments to a text file. 

Close the window after viewing the comments.

5. To view the user’s changes to the document, click the document’s title.

6. Close the document after viewing the changes. Then close the Response to 
Routing window.

7. If the task is complete, do one of the following:

• To move a task from the Tasks Assigned by Me list to your Deleted Tasks, 
click Delete This Job.

• To complete the task later, click Keep for Later. The task remains in the 
Tasks Assigned by Me list.

• To publish a document that has not been added to DocuShare (the word 
Unpublished appears after the document’s title), click the Properties icon that 
appears to the right of the document’s title. At the bottom of the View 
Properties page, click the Publish This Version button.

If the document was routed for approval and it was not approved, you can 
reroute the unpublished document by clicking the Route icon that appears to 
the right of the document’s title.

Step #: Username The task is pending and is on a specific step of a multi-
step task. It is currently being routed to all recipients in 
order; the user whose name is displayed has received the 
document, but has not taken any action.

Overdue For a single-step task or one step of a multi-step task that 
is overdue, the word Overdue appears after the task’s 
description.

Terminated The task is stopped because it cannot continue. This can 
occur when Cancel Task is set for Then Escalate or when 
a document or user is deleted from your site.

Table 12–1: Task status

Status Description
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Viewing progress reports
If you chose to be notified of a task’s progress, completion, or overdue status on the 
Routing Slip, you can view the notifications in the Routing Tasks window. 

To view a task’s progress report:

1. Do one of the following:

• On the navigation bar, click My Tasks.

• On the navigation bar, click My DocuShare. Then click Tasks.

The My Tasks window appears.

2. From the Show menu, select Tasks Assigned to Me.

The page lists the routing tasks, under Description, the date the task was 
assigned, and the type of report. Table 12–2 describes the report types.

3. To view a task’s progress report, click its Description. 

A Response to Routing window appears, which includes the routed document and 
shows the user’s comments.

4. To view the user’s changes to the document, click the document’s title.

You can save the user’s revised document as a new version of your routed 
document. See the next section, Publishing a new version of your routed 
document on page 12–10.

5. Close the document after viewing the changes.

6. In the Response to Routing window, do one of the following:

• To schedule a new due date for an overdue task, enter a new date in the Due 
Date field and click the Acknowledged button.

• To confirm reviewing the report, click the Acknowledged button.

• To review the report at a later time, click the Acknowledge Later button.

Table 12–2: Report type

Type Description

Response The recipient responded to the task.

Completion The task is complete.

Overdue The task is in progress past the completion date.

Termination The task is stopped because it cannot continue. This can 
occur when a document or user is deleted from your site.
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Publishing a new version of your routed document
If you routed a document for review, you can save a document that a recipient changed as 
a new version of your routed document. In the For Your Review window, the word New 
appears after the title of a document that a recipient changed.

To publish a new version of your routed document:

1. In the My Tasks window, select Tasks Assigned by Me.

2. Under Description, click the task that includes the changed document.

3. In the Report on Routing for Review window, click the name of the recipient who 
provided the changed document.

4. Click the document title to open it.

5. Save the document to a location on your computer, and then close the document 
window.

6. In the Report on Routing for Review window, click the Close button.

7. Click the Properties icon that appears to the right of the document’s title.

8. At the bottom of the View Properties page, click the Publish New Version button.

9. On the Add Version page, click the Browse button.

10. Navigate to the location on your local drive in which you saved the document in 
step 5, select it, and click Open.

The path to the document appears in the Filename field.

11. Optionally, change the document title and add a version comment.

12. Click Apply.

13. If a document version other than the latest is the preferred version, you are asked 
if you would like to set this version as the preferred version. Click Yes to change 
the preferred version; otherwise, click No.

For more information on document versions and the preferred version, see 
Managing document versions on page 4–9.

14. Click the Report on Routing for Review link in the Location path.

15. In the Report on Routing for Review window, do one of the following:

• To move the task from the Tasks Assigned by Me list to your Deleted Tasks, 
click Delete This Job

• To remove the task later, click Keep for Later. The task remains in the Tasks 
Assigned by Me list.
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Viewing the tasks assigned to you
The tasks assigned to you display in the My Tasks window or on My DocuShare. If you 
chose to receive an email message when a new task is assigned to you, the message 
includes a URL to the task.

Note: To receive an email message when a new task is assigned to you, your user 
account property Routing Task Notification must be set to Email and your email 
address must appear in the Email Address field.

To view the tasks assigned to you:

1. Do one of the following:

• On the navigation bar, click My Tasks. From the Show menu, select Tasks 
Assigned to Me. Any task marked Request is a task assigned to you.

• On the navigation bar, click My DocuShare. The tasks assigned to you 
display under Tasks.

2. Click a task to view it.

A window appears displaying your task. The following sections describe how to 
respond to routing tasks.

Approving or disapproving a document
1. In the For Your Approval window, click the document’s title.

The document opens in its native editor or a window appears allowing you to 
download the document.

Note: If the document version sent to you is not the latest version, a Latest published 
version link is included. You can click the link to view the latest version of the 
document.

2. Review the document.

3. When your review is complete, close the document.

4. You can repeat steps 1 through 3 for each routed document.

5. In the Comments field, enter an optional message.

6. Click Save as private if you do not want other recipients to view your comments.
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7. Do one of the following:

• To complete the task and approve the document, click the Approved button. 
The task is removed from the Tasks Assigned to Me list.

• To complete the task but not approve the document, click the Disapproved 
button. The task is removed from the Tasks Assigned to Me list.

• To not complete the task at this time, click the Respond Later button. The 
task remains in the Tasks Assigned to Me list.

Reviewing a document
1. In the For Your Review window, click the document’s title.

The document opens in its native editor or a window appears allowing you to 
download the document.

Note: If the document version sent to you is not the latest version, a Latest published 
version link is included. You can click the link to view the latest version of the 
document.

2. Review the document and make any changes you want.

3. Close the document and, if you made changes, save it to a location on your 
computer.

4. If you changed the document, do the following:

a. Click the Properties icon that appears to the right of the document’s title.
b. At the bottom of the View Properties page, click the Add Draft Version 

button.
c. On the Add Version page, click the Browse button.
d. Navigate to and select the document you changed, and then click Open.
e. Optionally, change the document title and add a version comment.
f. On the Add Version page, click Apply.
g. If a document version other than the latest is the preferred version, you are 

asked if you would like to set this version as the preferred version. Click Yes 
to change the preferred version; otherwise, click No.

h. On the View Properties page, click the For Your Review link in the Location 
path.

5. You can repeat steps 1 through 4 for each routed document.

6. In the Comments field, enter an optional message.

7. Click Save as private if you do not want other recipients to view your comments.

8. Do one of the following:

• To complete the task and remove it from the Tasks Assigned to Me list, click 
the Reviewed button.

• To not complete the task at this time, click the Review Later button. The task 
remains in the Tasks Assigned to Me list.
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Acknowledging receipt of a document
1. In the For Your Acknowledgement window, click the document’s title.

The document opens in its native editor or a window appears allowing you to 
download the document.

Note: If the document version sent to you is not the latest version, a Latest published 
version link is included. You can click the link to view the latest version of the 
document.

2. When you are finished viewing the document, close it.

3. You can repeat steps 1 and 2 for each routed document.

4. Do one of the following:

• To complete the task and remove it from the Tasks Assigned to Me list, click 
the Acknowledged button.

• To not complete the task at this time, click the Acknowledge Later button. 
The task remains in the Tasks Assigned to Me list.

Removing a document sent for information
1. In the For Your Information window, click the document’s title.

The document opens in its native editor or a window appears allowing you to 
download the document.

Note: If the document version sent to you is not the latest version, a Latest published 
version link is included. You can click the link to view the latest version of the 
document.

2. When you are finished viewing the document, close it.

3. You can repeat steps 1 and 2 for each routed document.

4. Do one of the following:

• To complete the task and remove it from the Tasks Assigned to Me list, click 
the Remove button.

• To not complete the task at this time, click the Remove Later button. The task 
remains in the Tasks Assigned to Me list.
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Viewing your deleted tasks
After you delete a completed task that you assigned by clicking the Delete This Job 
button, DocuShare saves the task. This provides you with a record of the completed 
routing tasks you assigned.

In addition, you can view the deleted routing tasks of a specific document. See Viewing 
the routing tasks of a document on page 12–15.

To view all of your deleted tasks:

1. Do one of the following:

• On the navigation bar, click My Tasks.

• On the navigation bar, click My DocuShare. Then click Tasks.

The My Tasks window appears.

2. From the Show menu, select Deleted Tasks.

Your deleted routing tasks display.
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Viewing the routing tasks of a document
The routing task owner and each recipient can view the routing status of a document or 
any of its versions on the Routing page for the document. The page displays both tasks in 
progress and deleted tasks.

To view a document’s routing tasks:

1. Do one of the following:

• Locate the document whose tasks you want to view.

• Open a routing report or request window that contains the document whose 
tasks you want to view.

2. Click the Properties icon that appears to the right of the document’s title.

The View Properties page appears.

3. Click the Routing link.

The tasks and their status display.
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About scanning documents
If you have access to a Xerox WorkCentre with the Scan to File feature enabled, you can 
scan documents to DocuShare. The WorkCentre converts your printed documents to TIFF 
format and stores the digital documents in a temporary collection on your DocuShare 
server. You can save your scanned documents to a permanent collection on your site.
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Scanning a document at a WorkCentre
Your WorkCentre administrator must set up a scan template before you can scan 
documents to DocuShare. When setting up a scan template, the administrator can choose 
to save each document page to a TIFF file or to save all of the document pages to a single 
TIFF file. Also, you may be able to use a scan template to enter DocuShare property 
values at the device, before scanning the document. After the document is scanned to a 
collection, the values you entered appear on the View Properties page for the document.

Before you begin, check with your administrator to find out which templates are available 
for your use and whether or not a password is required.

Note: Depending on which WorkCentre model you use, the steps for scanning a 
document can vary. DocuShare does not support scanning color images on a 
WorkCentre Pro 40 using JPEG compression (JPEG-in-TIFF).

To scan a document:

1. Place a document on the document glass or in the document feeder.

2. Press the Features button.

3. On the touch screen, press the Scan tab.

4. Press Scan to File.

5. Select the scan template.

6. If the template requires a password, do the following:

a. Press Added Features.
b. Press Filing Setups.
c. Press Login Name/Password.
d. Press Password.
e. Type your password and press Save.
f. Press Save.

7. If the template allows you to specify property values, enter values for the ones you 
want.

8. Press the Start button.

The WorkCentre scans the document and then sends it to the temporary scan collection 
on your DocuShare server. The document is stored in this collection for a designated time 
period. You can check the time period by clicking WorkCentre Scan Repository on the 
DocuShare home page. To keep the document, you need to save it to a permanent 
collection.
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Saving a scanned document to a collection
To save a scanned document to a collection, you must be logged in and have Writer 
access to the collection.

To save a scanned document to a collection:

1. Go to the DocuShare home page.

2. Click WorkCentre Scan Repository.

3. If the Passcode field appears, enter the password you entered at the WorkCentre 
to scan the document and then click Enter Passcode.

4. Locate your scanned document.

5. Click Save.

If you do not want to save the document to a collection, click Delete to remove the 
document from the temporary scan repository.

6. If you want to rotate the document, select the number of degrees from the Rotate 
Image menu and click Go.

7. From the Document Type menu, select the type of document to save the 
scanned document as.

The menu contains types in addition to Document if your administrator created 
custom documents on your site.

8. If your administrator specified a default collection in which to save scanned 
documents, its title appears in the Destination field. Do one of the following:

• If you want to use the default collection, go to step 13.

• If you want to change the collection, click Select. The Select Destination page 
appears.

9. In the Sort By field, select Title to display the collections in alphabetical order or 
select Handle to display the collections in numerical order.

10. Do one of the following:

• To find specific collections, enter any part of a collection title in the Search 
field. Click the Go button.

• To display all collections, click Show All.

• To display your favorite collections, click Show Favorites.

• To display your personal collection, click Show Personal Collection.

11. In the Possible Locations field, select the collection to which you want to save 
the document.

12. Click Apply.

13. In the Title field, enter a title for the document.

14. Enter any additional information. Click a field name for a description of each 
property.
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15. Click Save.

The document is saved to the collection you specified.

Note: Your administrator may have given you access to a collection named Temporary 
Scan Repository. Alternatively, you can open this collection to move or delete your 
scanned document.
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About archiving content
The DocuShare Archive Server enables your organization to conveniently increase 
document storage capacity while providing a safe location for archived content. If your site 
includes an Archive Server, you can move content from your site to a secondary server. 
When you need to retrieve your archived content, you can search for the object and, if 
needed, restore it.

Check with your DocuShare administrator to find out if your site uses an Archive Server.
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Archiving content
You can archive documents, Interact pages, and mail messages with attachments. When 
you archive a document, all of its versions also are archived. To quickly archive the 
contents of a collection, you can select the collection and archive it. However, only the 
documents, Interact pages, and mail messages in the collection and its subcollections are 
archived; the collection is not archived and remains on the DocuShare server.

There are two ways to archive content: Specify a date on which to have objects archived 
automatically, or select the objects you want to archive and use the Archive command. 
After an object is archived, it retains its properties, access list, and previous location on the 
DocuShare server.

You can archive an object if you are the logged-in owner of the object or a logged-in user 
with Manager access to it.

Archiving content automatically
By default, DocuShare uses the object's Expiration Date property to archive content 
automatically. Your DocuShare administrator can specify a different date property to use 
for archiving, so check with your administrator to find out which property you should use.

To archive content automatically:

1. Locate the object (document, Interact page, mail message) that you want to 
archive.

2. Click the object’s Properties icon.

3. Click the Edit link.

4. In the appropriate date field, enter the date on which you want the object archived.

5. Click Apply.

DocuShare archives the object on the date you specified.

Archiving content manually
To archive content manually:

1. Do one of the following:

• Navigate to and open the collection that contains the objects you want to 
archive.

• Run a search to find the objects you want to archive.

• Navigate to (but do not open) the collection that contains the objects you want 
to archive.

2. Do one of the following:

• To archive objects in an open collection or from a search, click the checkbox 
that appears next to the title of each object.

• To archive the contents of a collection, click the checkbox that appears next to 
the title of the collection.

3. From the Edit Selected menu, select Archive.
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The Confirm Move to Archive page appears.

Note: If a minus sign appears in the checkbox that precedes an object, then you do not 
have Manager access to the object and cannot archive it.

4. Click the Confirm button to move the objects to the Archive Server.

If you do not want to archive the objects, click Cancel.
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Restoring archived content
You can restore any object that you moved to the Archive Server to its previous location 
on DocuShare. If the DocuShare collection in which the object was located was deleted, 
you can add the object to another collection after restoring it. An object is restored with its 
associated properties and access list. However, if a user who previously appeared in the 
object’s access list was deleted from the DocuShare site, the user will not appear in the 
restored object’s access list. Also, if you are restoring an object that was owned by 
another user whose DocuShare account was deleted, you will become the new owner.

You can restore an object if you are the logged-in owner of the object or a logged-in user 
with Manager access to it.

To restore an archived object:

1. On the navigation bar, click the Advanced link.

The Advanced Search page displays.

2. Depending on the page from which you are running the search, select a search 
scope from the Search Within menu.

Note: The search scope you select is used on the Archive Server. When an object is 
archived, it retains its original location path. If you know any part of the object’s 
location path, you can narrow the search scope to speed the search.

3. In the Server to Search field, select Archive Server.

4. Specify the search terms and options you want.

5. Click Search.

The Search Results page displays. The words Appeared In followed by the 
collection name display under each object whose collection exists on DocuShare. 
If Appeared In and the collection name do not display, then the object’s collection 
was deleted. You can restore the object as an orphan and then add it to another 
collection.

6. Select the objects to restore.

7. From the Edit Selected menu, select Restore.

8. On the Confirm Restore From Archive page, click Confirm.

The Archive Restore Results page displays.

9. If the object is an orphan, do the following:

a. Click the checkbox that precedes it.
b. From the Edit Selected menu, select Change Location.
c. On the Confirm Change Location page, click Confirm.
d. Use the Change Location page to relocate the orphaned object.
The Archive Restore Results page displays and lists the new collection in which 
the object appears under the object’s title.
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Answers to frequently asked questions 
This section provides answers to some frequently asked questions about DocuShare. 

Table 15–1: FAQs

Problem Solution

Why am I unable to create an account 
on DocuShare?

Your administrator may have restricted 
account creation to either registered users or 
an administrator. Check with your DocuShare 
administrator.

Why am I unable to log into 
DocuShare?

Make sure you are using a browser that 
supports logging into a system. Check with 
your DocuShare administrator to find out 
which browsers support logging. Also, make 
sure your browser is set to accept cookies.

This problem can also occur when your 
browser is not set to refresh the page with 
every visit to it. In this case, you are actually 
logged in, but are seeing an out-of-date page.

I forgot my DocuShare username. 
What should I do?

On the navigation bar, click the Users & 
Groups link. On the List page click Show All 
to display all the users on your site. Locate 
and then click your name. The Username 
field on the Properties page displays your 
username.

I forgot my DocuShare password. 
What should I do?

Do not create another user account. Contact 
your DocuShare administrator, who can set 
another password for you.

Why does a newly added object not 
display when I search for it?

After adding an object to your site, wait a few 
seconds before searching for it as DocuShare 
needs to finish indexing the object and its 
properties.

Why does DocuShare find objects 
that contain a property value I did not 
specify?

When a property is assigned several comma-
separated values, DocuShare treats the 
comma like a space. Therefore, DocuShare 
will find objects that contain adjacent property 
values.

For example, if a document’s Author property 
value is Susan George, Taylor Jones, 
DocuShare will find the document if you 
search for Author or Any Part contains Susan 
George, Taylor Jones, or George Taylor.
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Why does Netscape Navigator hang 
when I try to upload a document to 
DocuShare?

Check to see if the document is open in its 
associated application (for example, Word or 
PowerPoint). If it is, close the document and 
try the upload again. (This is a suspected bug 
in the Netscape-Windows interaction.)

Why am I unable to see a document I 
uploaded to DocuShare? I did not 
have any problems during the upload.

Check your browser's proxy settings. You 
should not be using a proxy server to access 
your DocuShare server.

I uploaded a document to DocuShare 
and received an error saying it had an 
invalid index or was unable to open 
the collection. What should I do?

If you return to the collection to which the 
document was added, you should find that it 
was correctly uploaded. If so, the problem was 
with the search indexing step that occurs after 
your document has been uploaded. The 
document is stored but not indexed. Report 
the problem to your administrator.

When I click the title of a document in 
DocuShare, I get the message 
“Unknown File Type - You have 
started to download a file of type 
application/....” What should I do?

Make sure your browser is configured to use a 
helper application to view this type of 
document.

I am using Internet Explorer. When I 
click a PDF document in DocuShare, I 
just get a blank page. Why does the 
file not open?

This is a known interaction problem between 
Internet Explorer and Acrobat (PDF) files. 
Contact your administrator for help.

Why does the page does not display 
properly after I add HTML tags to the 
object's properties?

DocuShare allows you to add HTML tags to 
text-based properties such as an object's 
Description or Summary. You should limit use 
of HTML to simple formatting commands like 
font changes and lists. Including header 
commands like <HTML>, <HEAD>, or 
<BODY> will most likely interfere with 
DocuShare's own HTML commands, leaving a 
page that is either blank or very poorly 
formatted. You should also avoid using any 
tags in Title and Summary properties that 
affects the vertical layout, such as IMG and list 
directives, because those two properties are 
displayed in contexts that assume simple 
strings.

What should I do if I cannot find an 
object or a document?

DocuShare provides a variety of search 
features to help you quickly find objects. See 
DocuShare searches for information on how 
to run a search.

Table 15–1: FAQs

Problem Solution
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I am logged into DocuShare and 
when I try to access an object, I 
receive a message that states “Not 
Authorized.” What should I do?

Contact the object’s owner, who can give you 
access. 

I accidentally deleted a collection 
without deleting the objects it 
contained. Now I cannot find those 
objects. What should I do?

When you delete a collection, but not its 
contents, and the objects are not located in 
another collection, they become orphaned. 
You are unable to access orphaned objects 
from a collection. However, the objects are still 
stored on your site. Your administrator can 
relocate orphaned objects in a collection so 
you can access them again. Or, you can 
access an orphaned object if you know its 
unique address (for example, http://
sales.acme.com/docushare/dsweb/Get/
Document-128).

After moving a collection to a new 
location, why am I unable to find it in 
either the new or the old location?

You accidentally orphaned the collection, 
which means you cannot access it from 
another collection. The collection is still stored 
in DocuShare. Your administrator can recover 
the orphaned collection by relocating it in a 
collection. Or, you can access the collection if 
you know its unique address (for example, 
http://sales.acme.com/docushare/dsweb/Get/
Collection-12).

I deleted an object from a collection. 
Why can I still see it when I navigate 
to the collection page?

If you used the browser’s Back button, 
Favorites, or Bookmarks to navigate, you may 
have accessed a cached version of the 
collection page. Click the browser’s Refresh or 
Reload button to display the latest version of 
the page.

I logged into DocuShare, navigated 
the site, and then used my browser’s 
Back button a few times. Why am I 
now logged in as a Guest?

You have accessed a cached version of the 
page. Click the browser’s Refresh or Reload 
button to display the latest version of the 
page. You should see your username on the 
navigation bar.

I use Netscape Navigator to access 
DocuShare. After rotating a scanned 
image, why does it not appear 
rotated?

You need to change the browser’s cache 
setting. Open the Preferences window, and 
click Advanced then Cache. Under Compare 
the page in the cache to the page on the 
network, select Everytime I view the page.

Table 15–1: FAQs

Problem Solution
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Why can changing the permissions of 
a collection and its objects take longer 
than expected or time out?

The time it takes to change the permissions of 
a collection and its objects is dependent on 
the number of collection objects, which 
includes all nested collections and their 
contents. When changing the collection’s 
permissions, DocuShare must examine each 
object’s access list and either merge the 
changes or replace the access list. It is 
important to note that even if your browser 
times out, DocuShare is processing and will 
complete the permissions change.

As an alternative, your administrator can use 
a command line utility to change the 
permissions of a collection that contains a 
large number of objects. 

Table 15–1: FAQs

Problem Solution



Answers to frequently asked questions FAQs

15–6  User Guide

 
 



User Guide  A–1

 
 

WebDAV folders

• Using WebDAV folders. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–2



Using WebDAV folders

A–2  User Guide

 
 

Using WebDAV folders
DocuShare supports the WebDAV (Web Distributed Authoring and Versioning) protocol, 
which enables you to access DocuShare collections and documents through a WebDAV-
compliant folder. You do not need client software installed on your computer. If you are a 
Windows 2000 or XP user, simply go to My Network Places to add a DocuShare server 
as a network place. If you are using a Macintosh with OS X, select Connect to Server to 
add the URL for a DocuShare server.

Note: In both Windows and OS X, you must append the DocuShare server's URL with /
webdav. When you are prompted to log in, use your DocuShare username and 
password.

Document titles in WebDAV folders
Your DocuShare administrator controls how document titles are displayed in collections. 
For example, a title might have a file extension appended to it. If you have any questions 
about how document titles are displayed, see your administrator.
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logical operators

types 10–7
using in searches 10–6 to 10–7

M
Manager access permission 1–6, 5–2
mapping a user account to a federated 

server 2–6 to 2–7
members

changing for group 2–10
sending email to group 2–12

minus sign, using in searches 10–4
month view, calendar 6–2
My DocuShare

about 11–2
viewing browsing history 11–6
viewing favorites 11–3
viewing groups of which you are a 

member 11–6
viewing personal calendar 11–5
viewing personal collection 11–4
viewing routing tasks 11–7

My Tasks
using to check tasks you assigned 12–

7
using to view progress reports 12–9, 

12–14
using to view tasks assigned to you 

12–11

N
navigating DocuShare 1–4
navigation bar 1–4
nonalphanumeric characters, using in 

searches 10–9
notification

about 9–2
adding 9–3
changing properties 9–6
creating a recipient list for 9–5
deleting 9–7
events of interest 9–2
requirements for using 9–2
restoring deleted 9–7
time periods 9–3
turning off selected event notifications 

9–3
viewing 9–4
viewing properties 9–6

O
object properties 1–6
objects

See also calendar, collection, 
discussion, document, event, 
group account, saved query, topic, 
URL, user account

about 1–5
changing access permissions 5–4
changing owner 5–5
editing multiple in collection 3–7
icons 1–5
searching for 10–4 to 10–7

Or operator, using in searches 10–7
orphan object 4–13

adding to collection after restoring from 
Archive Server 14–5
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owner
changing for group 2–11
changing for object 5–5

P
PaperPort Link to DocuShare 1–9
password, changing 2–5
Paste (Edit Selected menu) 3–7
permissions, See access permissions
personal calendar 11–5

creating 11–5
personal collection 11–4

adding objects to 11–4
plus sign, using in searches 10–4
preferred version

and maximum versions 4–3
changing 4–9
defined 4–9

progress reports, viewing 12–9
properties, and objects 1–6

Q
question mark, using in searches 10–9
quotation marks, using in searches 10–4, 

10–6

R
Reader access permission 1–6, 5–2
recipient list

changing for document routing 12–4
creating for notification 9–5

recurring event
adding to calendar 6–8
deleting series of 6–11

removing user account mapping from a 
federated server 2–7

Rename (Edit Selected menu) 3–7
rendition

viewing for versions 4–10
viewing HTML 4–5

reply
adding to topic 7–7
changing properties 7–8
deleting 7–10
viewing properties 7–8

reserved characters, using in searches 10–
9

Restore (Edit Selected menu) 3–7
restoring archived content 14–5
restoring deleted objects 3–6, 4–14, 6–7, 

7–6, 8–6, 9–7, 10–13
retain login for future 1–7
Route (Edit Selected menu) 3–7
routed document

acknowledging receipt of 12–13
approving 12–11
disapproving 12–11
publishing new version of 12–10
removing after sent for information 12–

13
reviewing 12–12

routing a document
about 12–2
automatically after adding to collection 

12–6
including additional documents 12–5
routing order 12–4
to users 12–3 to ??
types of routing tasks 12–3
using a saved Routing Slip 12–3

Routing Slip 12–2
re-using 12–3
saving 12–5

routing tasks
checking status of your tasks 12–7 to 

12–8
deleting completed 12–8
viewing all deleted 12–14
viewing for document 12–15
viewing tasks assigned to you 11–7, 

12–11

S
saved query

adding to container 10–10
changing access permissions 5–4
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changing its location 10–12
changing owner 5–5
changing properties 10–11
restoring after deleting 10–13

saved Routing Slip, using 12–3
saving

a Routing Slip 12–5
scanned document to a collection 13–4
search query 10–10

scan template 13–3
scanned document

checking length of time in temporary 
collection 13–3

receiving URL after saving 13–4
saving to a collection 13–4

scanning documents
about 13–2
at a WorkCentre 13–3

Search Available to, defined 5–4
search words, separator 10–4
searches 10–2

See also saved query
how to specify exact phrase 10–4, 10–

6
running 10–4 to 10–7
saving 10–10
using minus signs 10–4
using nonalphanumeric characters 10–

9
using plus signs 10–4
using wildcards 10–9

searching for objects 10–4 to 10–7
combining search terms 10–6 to 10–7
finding user and group accounts 2–14
on federated servers 10–4, 10–6 to 10–

7
running a word search 10–4
using search options 10–5

snippet (document), showing and hiding in 
search results 10–4, 10–7

stemming 10–2

T
tasks, See routing tasks

temporary scan collection
checking how long scanned 

documents are stored 13–3
moving scanned document from 13–4

TIFF file, creating by scanning 13–3
topic

adding to discussion 7–7
changing access permissions 5–4
changing its location 7–9
changing owner 5–5
changing properties 7–8
deleting 7–10
deleting expired 7–11
replying to 7–7
viewing expired 7–11
viewing properties 7–8

trashcan, restoring objects from 3–6, 4–14, 
6–7, 7–6, 8–6, 9–7, 10–13

U
unlocking a document 4–11
uploading a document 4–3
URL

about 8–2
adding to container 8–3
changing access permissions 5–4
changing its location 8–5
changing owner 5–5
changing properties 8–4
deleting 8–6
restoring after deleting 8–6
viewing properties 8–4

user account
changing domain 2–5
changing password 2–5
changing properties 2–4
changing username 2–5
creating 2–3
deleting 2–5
mapping to federated server 2–6 to 2–7
removing user account mapped to 

federated server 2–7
searching for 2–14
viewing list of 2–14
viewing properties 2–4

username, changing 2–5
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V
version comments, adding 4–6, 4–8
version history, viewing 4–9
version, document

adding edited document 4–6
adding new document 4–8
changing preferred version 4–9
changing properties 4–10
publishing routed document 12–10
specifying maximum to save 4–3
viewing 4–9
viewing properties 4–10
viewing renditions 4–10

viewing
a document 4–4
a document in HTML format 4–5
access permissions 5–3
document version history 4–9
expired topics 7–11
new content 10–3
progress reports for routing tasks 12–9
version renditions 4–10

viewing properties
calendar 6–5
collection 3–4
discussion 7–4
document 4–12
event 6–9
group account 2–9
notification 9–6
reply 7–8
topic 7–8
URL 8–4
user account 2–4

W
WebDAV folder, using with DocuShare A–2
week view, calendar 6–2
What’s New

using 10–3
wildcards, using in searches 10–9
WorkCentre, and scanning documents 13–

3
workflow, See routing a document
Writer access permission 1–6, 5–2
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